Copyright © 2016 EPLAN Software & Service GmbH & Co. KG

EPLAN Software & Service GmbH & Co. KG assumes no liability for either technical or printing errors, or for deficiencies in this technical information and cannot be held liable for damages that may result directly or indirectly from the delivery, performance, and use of this material.

This document contains legally protected proprietary information that is subject to copyright. All rights are protected. This document or parts of this document may not be copied or reproduced by any other means without the prior consent of EPLAN Software & Service GmbH & Co. KG.

The software described in this document is subject to a licensing agreement. The use and reproduction of the software is only permitted within the framework of this agreement.

RITTAL® is a registered trademark of Rittal GmbH & Co. KG.

EPLAN®, EPLAN Electric P8®, EPLAN Fluid®, EPLAN Preplanning®, EPLAN PPE®, EPLAN Pro Panel® and EPLAN Hames proD® are registered trademarks of EPLAN Software & Service GmbH & Co. KG.


PC WORX®, CLIP PROJECT®, and INTERBUS® are registered trademarks of Phoenix Contact GmbH & Co.

AutoCAD® and AutoCAD Inventor® are registered trademarks of Autodesk, Inc.

STEP 7®, SIMATIC® and SIMATIC HW Konfig.® are registered trademarks of Siemens AG.

InstallShield® is a registered trademark of InstallShield, Inc.

Adobe® Reader® and Adobe® Acrobat® are registered trademarks of Adobe Systems Inc.

TwinCAT® is a registered trademark of Beckhoff Automation GmbH.

Unity Pro® is a registered trademark of Schneider Electric.

RSLogix 5000® and RSLogix Architect® are registered trademarks of Rockwell Automation.

All other product names and trade names are trademarks or registered trademarks of their respective owners.

EPLAN uses the Open Source software 7-Zip (7z.dll), Version 16.00, Copyright © by Igor Pavlov. The source code of 7-Zip is subject to the GNU Lesser General Public License (LGPL). The source code of 7-Zip and details on this license can be found on the following Web site: http://www.7-zip.org

EPLAN uses the Open Source software Open CASCADE, Version 6.9.1, Copyright © by Open CASCADE S.A.S. The source code of Open CASCADE is subject to the Open CASCADE Technology Public License. The source code of Open CASCADE and details on this license can be found on the following Web site: http://www.opencascade.org

EPLAN provides an import function which uses eCl@ss. Usage of the eCl@ss standard is subject to license and requires registration and ordering in the DownloadPortal: http://www.eclassdownload.com
# Table of Contents

**Preface** .......................................................................................................................... 9

**Notes for the Reader** .......................................................................................................... 11

**New Features of the Entire EPLAN Platform** ................................................................. 14

**Managing Wire Harnesses** ............................................................................................... 14
  - Importing and Exporting Wire Harness Data ................................................................. 14
  - Wire harness definition ................................................................................................. 15
  - Navigator for Wire Harnesses ...................................................................................... 17
  - Checking Wire Harnesses ............................................................................................ 20

**User Interface** .................................................................................................................... 20
  - Special representation of write-protected projects ..................................................... 20
  - Multilingual Filtering .................................................................................................. 22
  - Rapid Orientation in the Tree View through a New Popup Menu Item .................. 23
  - Improved Behavior at User-defined Property Configurations .................................. 23
  - Removed menu item for the symbol exchange ............................................................ 24

**Graphical Editor** ................................................................................................................ 25
  - Improved behavior when working with several projects ............................................ 25

**Macros** ................................................................................................................................ 25
  - Connections and potential tracking in macro projects ................................................ 25
  - Extensions to the macro navigator ................................................................................ 26

**Project Editing** .................................................................................................................. 28
  - Update the project databases ...................................................................................... 28
  - Modifying the page structure of projects subsequently .............................................. 29
  - Changing the identifier sequence .............................................................................. 30
  - Removing projects no longer required from the project management ....................... 32
  - Common editing of all the projects of a directory in the project management ............. 32

**Devices** ................................................................................................................................ 33
  - Highlighting of differences when editing the connection point logic .......................... 33

**Structure Identifier Management** ..................................................................................... 33
Finding used structure identifiers through the search results list ..................................33
Import descriptions from the pre-planning ........................................................................34

**Settings** ..........................................................................................................................35
Improvements for SQL databases ......................................................................................35
Renamed settings for the display of the navigators ............................................................36
Using the specified display of the tree structure at the page output ..................................36
Adapting the Page Scale Automatically to the Page Scale during a DXF / DWG Import ..........................................................38
Moved settings for project management database ............................................................39
Uniform Settings for the Usage of a Proxy Server ..............................................................39

**Labeling** ..........................................................................................................................40
Renamed and moved menu item .........................................................................................40

**Parts Management** ..........................................................................................................41
Update the parts database ....................................................................................................41
Extended parts data import to the eCl@ss standard ...........................................................41
New pre-filtering for parts ....................................................................................................43
Improved Block Editing at Tables .......................................................................................44
Improved Display after Parts Data Import .........................................................................45
Complete exporting of modules, etc. during an EDZ export ...............................................45
Renamed Fields .....................................................................................................................46

**Synchronization of Project Master Data** .....................................................................47
Displaying and updating of compressed symbol libraries ................................................47

**Further Utilities** ..............................................................................................................47
Specifying the Transfer of Project Properties during a Change of Standard ......................47
Scheme technique when deleting stored parts properties ....................................................48

**EPLAN Help System** ......................................................................................................49
Optimizing of layout, searching and navigation ................................................................49

**Properties** .........................................................................................................................51
Checking user-defined properties for invalid values ............................................................51
Display of the user-defined properties in accordance with the dialog language ................51
Placeholders for the Format of the Block Properties ..........................................................52
New property for displaying the scale ......................................................... 53
Determining the Page Counter per Property ............................................... 54

New Features in the "EPLAN Multiuser Management" Extension Module .... 55
Import and export of the overall configuration for defined working sections .... 55
New features for subprojects .......................................................................... 56

New Features in the "EPLAN User Rights Management" Extension Module" .......................................................... 57
Importing Windows users and groups .......................................................... 58

New Features for EPLAN Electric P8 ............................................................ 60

Terminals and Plugs ...................................................................................... 60
Improvements in editing terminals ............................................................... 60
Extensions for Main Terminals .................................................................... 65
Direct connections between terminals .......................................................... 67
Hidden "Connections" tab at terminals and pins ............................................. 68
Improvements in Working with Plugs .......................................................... 69

Cables ............................................................................................................. 71
Displaying the source and target of the cable ................................................. 71

New Features in the "EPLAN PLC & Bus Extension" Extension Module .... 72
Extensions for network connections .............................................................. 72
Improvements in the importing of bus configuration files ...................... 73
Keeping Line Breaks when Importing Assignment Lists ....................... 74
Display of the determined symbolic address in the assignment lists .......... 75
Additional format elements for assignment lists ........................................... 75
PLC Connection Points with Fixed Addresses ............................................. 77

New Features for EPLAN Pro Panel .............................................................. 78

Thermal Design Integration .......................................................................... 78
Views for the Thermal Design .................................................................. 80
Checking the Uneven Power Dissipation Layout in an Air-conditioning Field 82

Routing of Hydraulic Hose Lines and Pipings ............................................ 83

Collision Check for Freely Routed Routing Connections .......................... 84
Exchanging Enclosure Parts .......................................................... 84
Updating the Part Placement .......................................................... 86
Extensions when Placing Parts .................................................... 87
  Using length-variable items as "prefabricated" parts ....................... 87
  Multiple placement of parts without gaps .................................. 87
Display and Management of Mechanical Devices in Navigators .......... 88
Standardized and Automated Creation of Manufacturing Drawings ....... 90
  New Report "Cut-Out Legend" for 2D Drilling Views ...................... 91
  Accelerated Updating of Model Views ....................................... 92
Housing Configuration With the New Rittal Configuration System Configurator ......................................................... 92
Extension of the File Format for the Publishing of Projects ............... 93
Renamed Interfaces for Exporting Manufacturing Data .................... 93
New Features for EPLAN Preplanning ........................................... 95
  Extended Configuration of Segment Definitions .......................... 95
    Multiple selection of segment definitions ............................... 95
    Configuring the availability of tabs in the pre-planning ............. 95
    PCT loops insertable below planning objects .......................... 97
    Copying settings for segment properties ............................... 97
Extensions for PCT Loops and P&I Diagram .................................. 98
  Improved selection of structures ............................................ 98
  Subsequent Numbering of PCT Loops ....................................... 99
  Placing Structure Segments on P&I Diagrams .............................. 99
Pre-planning Navigator ............................................................... 101
  Display of objects no longer assigned from the detailed planning .... 101
  Improved sorting of the segments in a tree .............................. 102
Creating the Pre-planning ......................................................... 103
  Improvements in the importing of pre-planning data .................... 103
Creation of Schematics from the Pre-Planning .............................. 104
Taking into account only structure identifiers of the structure segments when generating the schematic ................................................................. 104

Conditional Forms for all Pre-planning Form Types ........................................ 106

Segment Templates .................................................................................. 107
Displaying property values from segment templates .................................... 107
Displaying the Description in the Segment Template Navigator ................. 107

New Features for EPLAN Fluid ................................................................. 108
Pipings in a Layout Space .......................................................................... 108
Routing Preconfigured Hose Lines ............................................................ 110
Checking the Connection Dimensions at Fluid Power Connections ............ 112

New Features in the "EPLAN API Extension" Extension Module ................. 117

New Features in the Master Data ............................................................... 125
Master Data: Symbols ................................................................................ 125
Master Data: Forms and Plot Frames ........................................................ 138
Master Data: Function Definition Library ................................................ 140
Master Data: Identifiers ............................................................................ 142
Master Data: Projects and Templates ......................................................... 142

Other New Features and Information ......................................................... 143
EPLAN Solution Center – the Support System ............................................ 143
Logging Into the EPLAN Solution Center ................................................ 143

Validation Code ........................................................................................ 146
Retrieving the Validation Code Online ........................................................ 146

Software Requirements and Approvals ..................................................... 148
General requirements .............................................................................. 148
Operating systems .................................................................................. 148
Microsoft products .................................................................................. 149
SQL Server (64-bit) .................................................................................. 149
Autodesk Server (64-bit) ........................................................................... 150
PDF redlining ................................................................. 150
PLC systems (PLC & bus extension) .................................. 150
64-bit version of the EPLAN platform .................................. 151
Modified Hardware Prerequisites ...................................... 152
Preface

Dear EPLAN users,

In the age of Industry 4.0 the development of machines and plants has become considerably more efficient through the integrated interaction of the engineering disciplines. Consistency in the exchange of engineering data is of increasing importance. Professional engineering solutions have to support this new working process – here the EPLAN platform systematically proves its strengths. With the new Version 2.6 we offer innovative functionalities to improve this interaction even further.

New possibilities have been created in the field of EPLAN Preplanning to simplify the synchronization of data from the pre-planning with the detail engineering. During a data import from external sources it is now also possible to recognize new, modified or also externally deleted objects simply in EPLAN Preplanning so that the user retains control of the data consistency.

Terminals and terminal strips are central items in connection technology and thus an important component of wiring systems in the engineering of automation technology. In the last version we had already extended the editing dialog for terminals in order to simplify the visualization and configuration of the terminal strip and make it more efficient. Even more possibilities have now been integrated. This turns this dialog into the control center for terminal strip editing. Users can now visualize the accessories used, easily recognize manual and automatic jumpers and represent the status of the terminal in the project planning. A new connection-oriented viewpoint lets the user recognize rapidly which terminal connections are still free.
Thermal Design Integration offers comprehensive support in the validation of the enclosure design in 3D and of the virtual dimensioning of efficient climate control solutions. The user can visualize the power dissipation density, display the optimal air-conditioning field and to make the different directions of the air flows within the 3D enclosure visible.

Get a head start and discover exciting further functionalities and improvements that the EPLAN Platform Version 2.6 offers you. We wish you every success!

Please visit our website at www.eplan.de/en/start/ for more information.

Your EPLAN Software & Service team
Notes for the Reader

Important information:

- *Before installing* the new version please read the information in "Other New Features and Information" (from Page "143") onwards. Read in particular the section "Software Requirements and Approvals" (see Page "148").

- As of Version 2.5 the EPLAN Platform is only available in a 64-bit version. Please read the subsection "64-bit version of the EPLAN Platform" in the section "Software Requirements and Approvals" for further information.

- If you want to use *old projects* that were created with previous EPLAN versions in EPLAN Version 2.6, these projects have to be updated. For further information read the section "Project Editing" (see Page "28").

- If you want to use an "*older* parts database", you will first have to update such a parts database. For further information read the section "Parts Management" (see Page "41").

- We used "EPLAN Electric P8" when creating the images for this document. If you use a different program of the EPLAN Platform, a different program icon will be displayed in the dialog of your program.

Before you begin reading, please note the following symbols and styles used in this document:
⚠️ **Warning:**

Text preceded by this symbol contains a warning; you should be absolutely sure to read this warning before proceeding!

甓 **Note:**

Text preceded by this image contains extra notes.

💡 **Tip:**

Useful tips to facilitate your interaction with the program are presented after this image.

💡 **Example:**

Examples are highlighted by this symbol.

- User interface elements are marked in **bold** (and **blue**) so they can immediately be located in the text.

- *Italic* text provides particularly important information that you should definitely pay attention to.

- Code examples, directory names, and direct input (among others) are displayed in a **non-proportional font**.

- Function keys, keyboard keys, and buttons within the program are shown in square brackets (e.g., *[F1]* for the "F1" function key).
To improve the flow of the text, we often use "menu paths" in this document (for example, Help > Contents). In order to find a particular program function, the menus and options shown in a menu path must be selected in the sequence shown. For example, the menu path mentioned above calls up the EPLAN help system.

In combination with settings or fields (e.g., check boxes) which can only be switched on or off, in this document we often use the term "activate" (after which the setting is active ☑️) and "deactivate" (after which the setting is inactive ☐️).
New Features of the Entire EPLAN Platform

Managing Wire Harnesses

As of this version new import and export functionalities are available for the data exchange with EPLAN Harness proD. By using these functionalities you can import wire harnesses designed in EPLAN Harness proD and the associated components into EPLAN projects, edit and report them there. You can subsequently export the wire harnesses and their components for renewed editing in EPLAN Harness proD.

**Benefit:**

*The new import and export functionalities for wire harness data facilitate the bidirectional data exchange between EPLAN Harness proD and the EPLAN platform. This increases the data consistency.*

We discuss the following topics in the next sections:

- "Importing and Exporting Wire Harness Data" on Page "14"
- "Wire harness definition" on Page "15"
- "Navigator for Wire Harnesses" on Page "17"
- "Checking Wire Harnesses" on Page "20".

Importing and Exporting Wire Harness Data

The following new menu items are available under the menu path Project data > Connections for the exchange of wire harness data with EPLAN Harness proD:
- **Import > Wire harness data**
  These menu items can be used to import the data of one or more wire harnesses. Synchronization with wire harness data (functions and connections) already existing in the project is carried out during importing. The dialog opened for this purpose is similar to the familiar synchronization dialogs that are opened, for example, during the import of devices / routing connections. If the wire harness data do not yet exist in the project, these are imported as unplaced functions and connections in the project.

- **Export > Wire harness data**
  These menu items can be used to export the wire harness data of a project.

**Wire harness definition**

Wire harnesses can be managed by using the new wire harness definition in the EPLAN platform. The wire harness definition identifies the wire harness and contains all the relevant data of the wire harness as well as the parts of the wire harness for which no corresponding EPLAN functions exist by default.

The new tab **Wire harness** is available in the property dialog for specifying the properties of a wire harness.
This tab is displayed when you open or create a wire harness (for example by using the wire harness navigator). Enter a unique name for the wire harness in the **Wire harness name** field or select an existing name from the drop-down list. In addition to the device tag a wire harness is identified by this wire harness name.

**Inserting wire harness definitions**

You can also insert a wire harness definition as a symbol without symbol graphics on a schematic page by using the symbol selection. To this purpose the new symbol `HDEF` as well as an associated function definition is available in the master data in the `SPECIAL` symbol library.

**Assigning functions and connections to a wire harness**

The assignment of functions and connections to a specific wire harness is carried out via the new property **Wire harness name** (ID 31143). You can select this property by using the property selection for the property table of a function or connection. Enter a new wire harness name here or select an existing name.

**Specific display of wire harness components**

You can use the new property **Wire harness name** in the following navigators as a filter criterion for the specific display and editing of wire harness components and display it as a column in the list view:

- Wire harness navigator
- Device Navigator
- Connections navigator
- Bill of materials navigator.
Through editing in tables you can assign or change a wire harness name rapidly and easily for selected functions and / or connections. The **Wire harness name** property is also available to this purpose for the column configuration of the tabs **Functions** and **Connections** when creating new schemes.

**Part**

The part of a wire harness assembly can be entered at the wire harness definition in the first line of the **Part** tab. The further lines of this tab are provided for parts (up to a maximum of 999) for which no corresponding EPLAN functions are available by default.

It is not absolutely necessary to create a wire harness assembly in the parts management. It is also possible to store parts only at the individual components of a wire harness (connections, cables, pins, etc.) during designing.

**Reports**

The parts data of the wire harnesses contained in a project can be listed in the bill of materials are be output in the corresponding reports (for example parts list, summarized parts list, etc.). You can specify in the dialog **Settings: Parts** whether only the wire harness assembly parts or / and the parts of the wire harness components are to be taken into consideration.

**Navigator for Wire Harnesses**

The new wire harness navigator is now available for the well-structured display and management of the wire harnesses imported into the EPLAN platform and of the components contained in the wire harnesses (connections, pins, cables, parts, etc.).

To open the wire harness navigator select the menu items **Project data > Connections > Wire harness navigator**.
Tree view

In the Tree tab, the wire harnesses of one or more projects are displayed in a hierarchical structure. The top hierarchy level is the project - in as far as several projects are opened. The wire harnesses are displayed under it (icon 🍃).

The hierarchical level below it contains the first part of the wire harness as well as the wire harness components - in as far as they exist. The components (connections, cables, pins, etc.) are subdivided into different hierarchical levels in accordance with the categories of the function definitions (icon 🍃). Otherwise these components are displayed similarly to in other navigators.

Special features:

- The components that are entered as further parts at the wire harness are displayed below the tree structure level Other wire harness components.
- Both the source and the target are displayed (separated by an arrow) for the cable connections displayed under the cable DTs.
- If the Part allocation property was used to specify for a part at a component that it is an accessory part this is displayed in an additional hierarchical level (icons for accessories 🛍, for parts (source) 🎀, for parts (target) 🡾).
The icons displayed in the tree view of the wire harness navigator include the following:

<table>
<thead>
<tr>
<th>Icon</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>□</td>
<td>Identifies the project level. This icon is only displayed when several projects are open.</td>
</tr>
<tr>
<td>🪚</td>
<td>Wire harness</td>
</tr>
</tbody>
</table>
| 🛒   | Part  
(Depending on the hierarchical level: Part of a wire harness assembly or of a wire harness component) |
| 📰   | Category of the function definition  
(At wire harness components such as connections, cables, pins, etc.) |
| 🦄    | Device |
| 📉   | Function  
(Here, for example, multi-line connection, such as the conductors of a cable) |
| 🛎️   | Part allocation: Accessories |
| 🔗   | Part allocation: Part (source) |
| 🔴   | Part allocation: Part (target) |
| 🍃   | Other wire harness components |
List view
Displays the wire harnesses of one or more projects and the components contained in the wire harnesses in a list. The view of the wire harnesses depends on the column configuration selected in the Configure representation dialog.

Checking Wire Harnesses
You are supported during the design and configuration of wire harnesses by check run messages of the new message class 033 "Wire harness". The check run messages 033001 and 033002 list those functions / connections that are assigned to a wire harness but for which no wire harness definition exists in the project.

In addition the check run message 033003 is available to check whether the parts of a wire harness assembly stored in the parts management match the components installed in the project. If, for example, a component (a cable, a plug, etc.) is missing or an incorrect part is stored, a corresponding message is generated.

User Interface

Special representation of write-protected projects
In order to distinguish write-protected projects better from other projects in the user interface in future, such projects are now always identified by a gray text background in the tree and list views of the navigators.
Benefit:

Through the special representation in the navigators and the separate color settings you can distinguish write-protected template projects and their opened pages / layout spaces more easily from other projects and their pages / layout spaces.

New separate color settings are now available for the representation of opened pages and layout spaces. The **Color settings of write-protected projects** group box has been added to the dialog **Settings: User interface** to this purpose.
Through the settings **Scheme (2D), Shading - Background 1 (3D)** and **Shading - Background 2 (3D)** you can specify separate color settings for the graphical editor and the 3D view for write-protected projects. By default other background colors are set here than in the user-defined 2D and 3D color settings for graphical editing. Gray background colors are used as the default setting.

For further information about the topic "Working with several projects" please also refer to the section "Improved Behavior when Working with Several Projects" (on Page "25").

**Multilingual Filtering**

The new column **Language** is now available in the filter dialogs. Through the drop-down list you can specify specifically in which language a filter criterion is to be used.

If you now specify a comparative value as the filter criterion for a multilingual property, you subsequently have the possibility to select a language. The default setting is "All project languages". If a specific language is selected, the search is only carried out in this language. Multilingual input in the **Value** is no longer possible.
Rapid Orientation in the Tree View through a New Popup Menu Item

The Select device in tree popup menu item is now available in the list view of the page navigator and many other navigators as a counterpiece to the List with preselection popup menu item. This menu item displays the marked object in the Tree tab. Multiple selection is possible.

**Benefit:**

The Select device in tree popup menu item provides rapid orientation in the respective hierarchical structure.

Improved Behavior at User-defined Property Configurations

At the user-defined property configurations of property tables the filled, manually modifiable properties were always also displayed in the past. These properties did not belong to the property configuration, but could not be removed permanently from the group box Properties and thus resulted in partially unstructured and cluttered property tables.

In the new version only the configured properties are still displayed for user-defined property configurations. The behavior has not changed for the predefined property categories (data, settings, etc.)—filled-in, manually modifiable properties are always displayed and cannot be removed.
**Benefit:**

The fact that only the configurable properties are still displayed at the user-defined property configurations corresponds to the expectations of the users and facilitates their use. The user-defined property configurations are now better structured in particular in those areas in which many manually configurable properties with filled values occur.

**Removed menu item for the symbol exchange**

Each decision if a menu item should be removed was also influenced by the findings from our "customer-focused improvement program". Your participation makes it possible for us to continuously enhance user-friendliness and performance of the EPLAN platform!

The following menu item has been removed in the **Utilities** menu:

- **Exchange symbols single-line <--> multi-line**
  
  This rarely used functionality with which single-line symbols could be converted into multi-line ones and vice versa has now been dropped.
Graphical Editor

Improved behavior when working with several projects
If in the past you worked simultaneously in several projects (for example macro and schematics projects) and opened a page in a different project, the currently opened page of the first project was always closed. This behavior has now been improved - a separate graphical editor / a separate 3D view is now opened for each project.

If you have opened more than one project, a separate graphical editor / 3D view is always opened whenever a page / layout space from a further project is opened. When a project is closed, all the associated graphical editors are closed again.

For further information about the topic "Working with several projects" please also refer to the section "Special representation of write-protected projects" (on Page "20").

Macros

Connections and potential tracking in macro projects
Connections are now also generated in macro projects. Interruption points are also recognized as connection targets. In addition to the autoconnecting lines, the connections and the potential tracking are now also highlighted in accordance with the set colors on the pages in the macro project.

Bundle connections and net connections are not generated in macro projects. The connections are updated automatically when switching between schematic and macro projects.
Benefit:

The connections and potentials are now displayed in the macro project exactly as they are later in the schematic project. This allows you to prepare the macros to be generated in the macro project more specifically for use in the schematic - frequent switching between the macro and schematic project is superfluous.

Extensions to the macro navigator

Displaying the macro descriptions in the tree view

Since the macro name is not always sufficient to identify a prepared macro, the macro descriptions are now also displayed (in brackets) additionally in the tree view behind the variant designation / the page name.

You can effect this new default display as usual via the popup menu item Configure representation. The Macro: Version property is now offered for selection in addition to the macro description in the dialog Configure representation. If the corresponding check box is activated, the values entered at the macros for the version are also displayed in brackets behind the variant designation / page name.

Tree structure level for prepared macros without name

In the past macros whose names were missing in the Macro box were not displayed in the tree of the macro navigator. In order to find the macro boxes more easily in future, such macros are now sorted into the "Without name" tree structure level.
Filtering and sorting specifically by macro type

You can now use the new property **Macro: Type** (ID 23010) in the macro navigator as a filter criterion for the targeted display, sorting and editing of the various macro types and display it as a column in the list view of this navigator.

New popup menu item "Generate macros"

In this version the popup menu item **Generate macros** has been added to the tree and list of the macro navigator. This allows you to automatically generate macros in the macro project rapidly and simply on the basis of the current selection (for example a single prepared macro).
Project Editing

Update the project databases
As part of miscellaneous extensions and optimizations, the project databases have been changed in Version 2.6. These modifications and optimizations make it possible to create new projects essentially with new project databases.

Consequences for legacy projects
In order for old projects to be edited (or also just viewed) in the new EPLAN version, updating of the project databases is absolutely essential for these projects. Old projects are updated the first time they are opened with the current EPLAN version. At the time, you will be prompted whether you wish to import the project in the current version.

If you confirm with [Yes], the project is first updated and then opened. In addition, a backup copy with the not-updated project databases is created in the project directory. This backup file *.zw1 can be restored via the data backup - as usual.

If you do not update an old project, you will not be able to open this project in the version 2.6.

⚠️ Caution:
It will no longer be possible to open new projects and old projects that have been updated with old EPLAN versions.
Modifying the page structure of projects subsequently

In the past you could only modify the page structure specified in the project properties only as long as a project does not contain any pages. In the new version it is now also possible to modify the page structure of a project even if the project already contains pages.

If a project disposess of pages, the Pages drop-down list on the Structure tab in the project properties is no longer grayed out. You can now select a different scheme for the page structure or use [...] to branch to the subsequent dialog Page structure and enter a new identifying scheme there. You can edit the predefined schemes (such as "Higher-level function") in this subsequent dialog.

Whether the modifications carried out are possible depends on certain requirements:
- **Extension of the page structure:**
  An extension of the page structure by a further identifier block (for example setting the "Document type" structure to "Identifying") or the changing of an identifier block from "Describing" to "Identifying" is always possible.

- **Reduction of the page structure:**
  A reduction of the page structure (meaning subsequently changing an identifying identifier block to "Describing" or "Not available") is only possible if no duplicate pages arise through this change.

- **No change in the page structure:**
  If a reduction of the page structure would result in duplicate pages, this change is not possible and a corresponding message is displayed. In such a case up to 10 possible pages are listed in the system messages. In order to make modification of the page structure possible you have to adapt these pages so that unique complete page names result.

**Changing the identifier sequence**

When specifying the page structure in the past you only had the possibility to chose between a default sequence and the identifier sequences "Document type first" and "User-defined first". If you now create or edit identifier schemes in the dialog Page structure, you can change the identifier sequence freely. To this purpose the toolbar with the familiar arrow buttons is available above the table with the identifier blocks.
**Notes:**

- The object identifier may *only* be used in combination with the **Document type** identifier block. A combination of object identifier and other identifier blocks is not possible. If you activate the **Use for structuring** check box for using the object identifier, the table with the identifier blocks is therefore grayed out (with the exception of the document type), and the identifier sequence cannot be changed.

- If you change the identifier sequence for the page structure, the settings for the tree representations off the pages are adapted automatically in the dialog **Settings: Tree structure (pages)**, provided these corresponded to the old page structure beforehand.
You can influence the sequence and the display of the structure identifiers in the tree structures of the navigator through the project settings. For further information also read the sections "Renamed settings for the display of the navigators" (see Page "36") and "Using the specified display of the tree structure at the page output" (see Page "36").

**Removing projects no longer required from the project management**

In the past it was not possible to remove directories and the projects contained in them from the project management once they had been read in. For this reason the popup menu item **Remove from project management** is now available in the tree view of the project management at the computer icons and at all other nodes. This menu item removes marked projects or marked nodes including all subdirectories and the projects contained in them from the project management.

**Common editing of all the projects of a directory in the project management**

If you mark a directory in the tree view of the project management in Version 2.6, this has the same effect as if you had selected all the projects in the directory. In such a case, for example, most of the menu items located below the [Organize] and [Extras] buttons are available. This allows you to edit all the projects below a directory together (for example Automated processing).
Devices

Highlighting of differences when editing the connection point logic

You edit the logic model of the function in the Connection point logic dialog. Editing has been now been facilitated. If the entries in the fields differ from the default values of the underlying function definition, these are highlighted by a yellow background.

In order to find such functions at which the logic model is set deviating from the function definition in a project, the new check run message 007026 is available in the message class 007 "Devices".

Structure Identifier Management

Finding used structure identifiers through the search results list

The number of times a structure identifier is used in the project can be shown in the Usage column of the structure identifiers. The popup menu item Insert into list of search results is now available in tree and list views of the dialog Identifier in order to find used points of the structure identifiers in the project.
Benefit:

The popup menu item Insert into list of search results makes the difficult search for the points of usage of the structure identifiers in the project superfluous. It is much easier to find the used structure identifiers.

This popup menu item checks the usage of the marked structure identifiers in the project and enters the found objects into the search results list. The entries already existing in the results list are deleted. You can jump to the objects on the project pages from the results list.

Import descriptions from the pre-planning

In the structure identifier management it is now possible to apply the descriptions of structure segments from the pre-planning as structure descriptions of the identifiers.

To this purpose the new menu item Import descriptions from pre-planning is available below the [Extras] button in the dialog Identifiers - <Project name>. (This button is only available in the List tab.) When you execute this menu, the description of the segment is applied as the structure description at all the structure identifiers that are assigned to a structure segment in the pre-planning. Existing structure descriptions are overwritten. If the structure description for a structure identifier is not unique in the pre-planning, a message is displayed that the description cannot be applied.
Settings

Improvements for SQL databases
Selection list for rapid switching between SQL databases
You can specify the use of an SQL server in the settings for the dictionary, the parts database and the project database. If you activate the SQL server option in one of the settings dialogs, a drop-down list with the 15 SQL databases last used is displayed for selection. The databases used last are listed at the top. The list can be emptied with the exception of the database currently being used via the popup menu item Delete entries.

Benefit:
You can switch rapidly between various SQL databases by using the selection list with the last SQL databases used.

Selection option for SQL databases
In the past you had to explicitly know and manually enter the name of the respective database when specifying the database in the subsequent dialog SQL server setting. Now you can select the name of a database on the SQL server in the SQL server settings. To this purpose the names of all the databases already existing on the specified server are offered for selection in the drop-down list of the Database – at correct specification.
**Benefit:**

The selection option at the SQL databases facilitates the utilization of SQL servers – in particular if you work with several SQL databases in the field of the parts management. The tedious entry of a database name is superfluous.

Renamed settings for the display of the navigators

Since the project-specific settings with the designation "Project structure" do not have any influence on the project structure, but rather specify the tree views of the pages and project data in the navigators, these settings have been renamed for the current version:

<table>
<thead>
<tr>
<th>Old designation</th>
<th>New designation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Settings: Project structure (navigators)</td>
<td>Settings: Tree structure (navigators)</td>
</tr>
<tr>
<td>Settings: Project structure (pages)</td>
<td>Settings: Tree structure (pages)</td>
</tr>
</tbody>
</table>

The menu paths of the settings dialogs have been changed correspondingly and are now named: **Options > Settings > Projects > "Project name" > Display > Tree structure (...).**

Using the specified display of the tree structure at the page output

In the past the logical sequence of the pages in the list view of the page navigator was decisive at the page output (and at other functionalities). To allow the specified display of the tree structure to be taken into consideration the **Also use representation sequence for page outputs** check box has been added to the dialog **Settings: Tree structure (pages).**
If the check box is activated, the sequence for the tree structure of the page navigator specified in this dialog is also used for the following functionalities:

- Scroll through pages in the graphical editor
- Printing pages
- Exporting pages as a PDF file
- Exporting pages in DXF / DWG format
- Output pages in the properties Next page / Previous page.

**Note:**

The settings in the dialogs Settings: Tree structure (…) do not have any influence on the list representations of the navigators. These still display the logical sequence of the pages and project data.
Adapting the Page Scale Automatically to the Page Scale during a DXF / DWG Import

The new setting **Adapt page scale** is now available in the **Import** tab in the dialog **Settings: DXF / DWG export and import**. (The menu path for the settings dialog is: **Options > Settings > User > Interfaces > DXF / DWG export and import**.)

Activate this check box if you want to import DXF / DWG diagrams with very large extensions (hall layouts, site plans, etc.). The DXF / DWG import is adapted as follows so that correct line thicknesses and dimensions can be generated at such drawings:

- The drawings are imported without scaling in a scale of 1:1.
- The drawing contents is centered in the EPLAN plot frame after the import.
- The page scale of the generated EPLAN page is adapted automatically to the drawing size.

**Note:**

Do *not* activate the **Adapt page scale** setting when you insert a DXF / DWG file via the menu items **Insert > Graphic > DXF / DWG** on a page in the graphical editor. The page scale cannot be adapted automatically during the import to an existing page.

The setting **Adapt page scale** is activated by default in the "Standard" DXF import scheme. For more information on this topic please refer to the context-sensitive help of the **Import** tab.
Moved settings for project management database

In order to harmonize with the settings for the other Access / SQL Server databases the settings for the project management database have been moved to the user settings. The settings dialog is located under: **Options > Settings > User > Management > Project management database.**

Uniform Settings for the Usage of a Proxy Server

If you use a proxy server, you had to specify the settings for the proxy server at various points in the past. These settings have now been harmonized so that there is now only one central settings dialog. The new settings dialog **Settings: Proxy server** is located under: **Options > Settings > User > Management > Proxy server.**

The settings specified in this dialog are used for all the program components that establish a connection to the Internet. If you specify the usage of a proxy server, these settings are now also used for program components such as the EPLAN Download Manager, the EPLAN online help system, etc.

In the **Connections** tab you specify, as in the past, whether a proxy server is used and in this case specify how it is addressed. The program components that establish a connection to the Internet as well as the associated URL are displayed in the new **Connection test** tab. You can test the connection there. If you use a proxy server there, the connection via the proxy server is tested.
Labeling

Renamed and moved menu item

The "Labeling" functionality makes it possible to output reported project data in various file formats. Since these files can be used not only to label item labels, but also generally for external further processing, the menu item for labeling has been renamed in this version:

<table>
<thead>
<tr>
<th>Old designation</th>
<th>New designation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Labeling</td>
<td>Export / Labeling</td>
</tr>
</tbody>
</table>

In addition the menu item that used to be located below the menu path Utilities > Reports has been grouped together with other menu items for the output of manufacturing data below the new menu item Manufacturing data. In the context of these changes the associated dialogs for labeling have been renamed correspondingly.
Parts Management

Update the parts database
If you work with several EPLAN versions (e.g., when switching to version 2.6) and have in version 2.6 an "older" parts database, you will be prompted upon opening parts management to update the parts database. If you answer this prompt with [Yes], the parts database is updated.

If you click [No], then the parts database is not updated. The parts management data fields will then remain empty and cannot be edited.

Other program features which also access the data in the parts database will output an equivalent message if the parts database does not correspond to the current version.

Note:
If you work with several EPLAN versions, then we recommend using the latest EPLAN version when editing and managing the parts database. An updated parts database can be opened in older EPLAN versions, for example, to select parts or devices, but cannot be edited.

Extended parts data import to the eCl@ss standard
eCl@ss is a standardized, cross-trade classification system for product groups, product characteristics and services with the aim of simplifying electronic trading of classified products.

Since Version 2.4 the EPLAN platform supports the importing of parts data into the parts management in accordance with the "eCl@ss Basic" standard
in Version 8.0. In the new version the eCl@ss standard is now supported in Version 9.0.

Benefit:

*The extended parts data import to the eCl@ss standard allows you to use standardized digital device data consistently from engineering through to the production.*

Addition of "eCl@ss Advanced"

During an eCl@ss import of parts data the XML-based standardized exchange format "BMEcat" is used. With the "BMEcat 2005.1" format that is now supported you can also import data in the "eCl@ss Advanced" version. The "eCl@ss Basic" version continues to be supported.

The "eCl@ss Advanced" version utilizes structured properties, dynamic elements and additional data types (for example for coordinate specifications of the connecting points of a device). This allows complex products to also be described comprehensively.

Extensions in the settings

In the past you could only configure the eCl@ss import if a concrete XML file in BMEcat format existed. Now import configuration is carried out by means of the scheme technique without such a file having to exist.

You can now open the associated settings dialog directly from the dialog Import records. To do so select the "eCl@ss 9.0 (BMEcat 2005.1)" entry in the File type field and click the adjacent [...] button. In the dialog Settings: eCl@ss import you define the settings for the import of eCl@ss data and can save these settings as a scheme.
Notes:

- The utilization of the eCl@ss standards is subject to license from the "eCl@ss e.V." organization and requires registration and ordering in the DownloadPortal: http://www.eclassdownload.com.
- In the EPLAN platform the new possibility of importing parts data to the "eCl@ss 9.0" standard is available for users with a valid Software Service agreement.

Further information about this topic is available in the help system in the section "Parts Management: Importing Parts Data to the eCl@ss Standard".

New pre-filtering for parts

In the new version it is now possible to pre-filter the parts of the parts management, of the parts selection and the device selection and of the parts master data navigator on the basis of specific properties.

Benefit:

The use of a pre-filter reduces the amount of parts offered, thus significantly simplifying and accelerating the search. You can thus, for example, exclude the display of the discontinued parts in the parts management (and similar dialogs) through the pre-defined supplied filter "Without discontinued parts".

To this purpose the new dialog Settings: Parts pre-filtering is available in the settings (menu path Options > Settings > User > Management > Parts pre-filtering).
Pre-filtering is carried out using the scheme technique. You can select filter schemes already defined in the settings dialog through the drop-down list of the Filter box. Through [...] you branch into the dialog Filter in which you can for example create a new scheme and assign filter criteria. To this purpose the dialog Criteria selection provides parts properties such as Discontinued part, ERP number etc.

Visualization of the pre-filter

If a filter is activated in the settings for the parts pre-filtering, a percentage sign "%" is displayed in the title bar of the relevant dialogs in front of the name of the parts database (for example Parts management - %ESS_part001.mdb).

Improved Block Editing at Tables

When in the past you marked several parts (or other objects of the same type) in the tree or list view of the parts management it was not possible in the tables of different tabs to add new lines by using the (New) button or to delete lines by using the (Delete) button. The block editing function at these tables has been extended for the current version.

This means that you can, for example, simultaneously assign accessory parts or lists to several marked parts in one action in the Accessories tab. Or you add new parts simultaneously to several marked accessory lists in the Parts tab. Deleting of lines is now also possible in block editing.

As is usual in block editing those lines that have different values are identified by the string <<...>> in the parts management when you simultaneously edit several objects (parts, accessory lists, etc.). If the number of lines differ, only those lines that are common to all the selected objects can be edited.
Improved Display after Parts Data Import

In Version 2.6 you are supported by an improved display after parts data have been imported. If a single part is imported or is updated through the import, this part is subsequently marked automatically. If several parts are imported or are updated through the import, the first of these parts is subsequently marked. This applies for the tree, list and combined views of the parts management.

*Benefit:*

*Through the improved display you can now recognize whether parts data have been imported. The first imported and automatically marked part can be edited immediately.*

Complete exporting of modules, etc. during an EDZ export

During the export of parts data using the *EPLAN Data Portal exchange format* the module part or the accessory list were in the past exported at modules, accessory lists, etc. but not the subparts belonging to the record type with the associated data. In order to include such reference data in future the parts data export has been extended for this format.

When you now select the file type "EPLAN Data Portal exchange format (EDZ)" in the dialog *Export records*, you can now use the [...] button to specify the data to be exported. Activate the *Export referenced data completely* check box if the associated data (subparts, submodules, etc.) are to be included in the export in addition to the respective main parts, accessory lists, etc. when exporting modules, accessory lists, etc.

The referenced data are included automatically when parts data are imported using the EPLAN Data Portal exchange format.
Renamed Fields

The following fields in the parts management have been renamed in Version 2.6 for the sake of clarity:

<table>
<thead>
<tr>
<th>Old designation</th>
<th>New designation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Creator</td>
<td>Creation date</td>
</tr>
<tr>
<td>Power dissipation</td>
<td>Max. power dissipation</td>
</tr>
</tbody>
</table>

The **Creation date** field is for example located in the **Prices / Other, Drilling pattern, Accessory list**, etc. tabs of the parts management. With its renaming it has been adapted to the field lying below it, **Last change**, so that both fields are now recognized as date fields.

In addition to the **Power dissipation** field that is, for example, available in the tabs **Component data, Terminal data** and **Contactor data**, the associated part property (ID 22074) has also been renamed.
Synchronization of Project Master Data

Displaying and updating of compressed symbol libraries

When compressing projects the symbol libraries included in the project are also compressed under certain settings. During a subsequent synchronization of the project master data with the system master data it was very difficult for these compressed symbol libraries to be identified due to a new modification date.

The entry "Compressed symbol library" is now displayed in the Type column of the dialog Master data synchronization for compressed symbol libraries from the project master data. In order to replace compressed symbol libraries in the project master data by symbol libraries from the system master data the new menu item Compressed symbol libraries in the project is now available below the [Update] button.

Further Utilities

Specifying the Transfer of Project Properties during a Change of Standard

In the past the project properties from the project template were always transferred in the target project. In the new version you now have the additional option to transfer the project properties from the source project into the target project. To do this activate the new check box Apply project properties from the source project in the Project tab of the dialog Change of standard.
Scheme technique when deleting stored parts properties

The scheme technique option has now been added to the **Delete stored part properties** dialog. This now makes it possible to easily remove data specifically during certain editing phases. For example, you need prices during the offer phase, but not during commissioning.

**Benefit:**

*Tedious manual specification of the part properties to be deleted at various deleting processes is no longer required. By storing various configurations as schemes you can switch rapidly and simply between these.*

After the **Utilities > Parts > Delete stored properties** menu items have been selected, the **Delete stored part properties** dialog is opened. Here you select a scheme from the **Settings** drop-down list or click [...] to open a subsequent dialog in which you can edit existing schemes or create a scheme.

You select the part properties to be deleted by clicking ![New](New) (New) and selecting the part property to be deleted in the **Property selection** dialog. Multiple selection is possible.
EPLAN Help System

Optimizing of layout, searching and navigation
The EPLAN help system introduced in Version 2.5 has been optimized further for the current version.

Benefit:

Through the partial text search and an optimized search algorithm you access the required information faster. The modern layout ensures a better overview: You can find and process the information faster.

Layout

Color, text size and row spacing have been modified to increase the overview in the continuous text. The headers now differ more strongly so that a hierarchy can be recognized immediately.

Many longer texts are now located in drop-down text boxes that you can expand by clicking the header. This ensures that only that section of the text is displayed that is of interest for you.

EPLAN Overviews

All the information about the EPLAN properties and the EPLAN placeholder elements are now available in interactive tables. You can sort these tables in ascending and descending order according to your requirements.
Searching and navigation

- The partial text search allows the entry of incomplete search terms from 6 characters length upward.

- The extended input field for the text search also shows longer search terms completely.

- The colored highlighting of the search term in the find locations is correct even if the search term contains special characters such as umlauts.

- When you scroll down in the text section, a button is displayed in the bottom right-hand corner that can be used to jump to the beginning of the text.

- Contents of the EPLAN help system now have a higher ranking in Internet search engines.
Properties

Checking user-defined properties for invalid values

During the configuration of user-defined properties you can define own selection lists with fixed default values. It is possible for the user-defined properties to have values that are not configured as default values for the respective selection list through various actions (such as copying and pasting from other projects, macro insertion, etc.). The new check run message 022060 is now available in the message class 022 "Other" in order to find such points with invalid values in the project.

**Benefit:**

*Through the new check run message 022060 you can list those points in the project at which the user-defined properties deviate from the allowed default values in the message management and subsequently correct them.*

Display of the user-defined properties in accordance with the dialog language

In the user-defined properties the project-specific translation setting **Source language** used to be decisive for the display of a translated displayed name. If, for example, "de_DE" is set here, the displayed name of such properties continues to be displayed in German even when the dialog language is changed (for example to "en_US"). With the new version the translated displayed name of the user-defined properties is now determined by the set dialog language.
Placeholders for the Format of the Block Properties

The block properties make it possible to format properties together and to display the property values in the schematic or output them to reports. When specifying the formatting in the dialog **Format: Block property** you can use the **Hide property if** group box to specify when a property is to be displayed or hidden. You can now also use placeholders such as "*" and "?" when entering the value.

**Benefit:**

The usage of placeholders when entering values provides you with greater flexibility when hiding properties by using the block properties.
Example:

You can use the placeholders in the format of the block properties for example to exclude specific external documents from the report (for example all German ones that contain the string "de_DE" in their name).

New property for displaying the scale

The **Scale** (ID 11048) page property for displaying the scale on schematic pages cannot display the entered ratio (for example "10:1" or "1:4") in this form in the graphical editor. For this reason the new page property **Scale (ratio)** (ID 11044) that displays the contents of the **Scale** (ID 11048) property correctly as a ratio is now available. You can place this property as a special text on project pages and on plot frames. For reasons of compatibility the "old" property for displaying the scale is retained.
Determining the Page Counter per Property

The new page property **Page counter per property** (ID 11064) is now available in addition to the properties already known **Number of pages per property** and **Page name per property**. With this property you can have the information displayed in the page properties or in a plot frame on the number of pages including the present one exist with a specific property (for example page 4 with higher-level function A31).

The configuration of the used property is effected through the existing project setting **Number of pages / Page name per property**. The menu items already existing **Page > Number of pages / Page name per property** are used to enumerate the pages that have the same value of a specific property, and the counter is written into the page property **Page counter per property**.
New Features in the "EPLAN Multiuser Management" Extension Module

Note:
The "EPLAN Multiuser Management" extension module is available as an optional extra for the following programming variants:
This extension module is part of the default scope of delivery for the following program variants: EPLAN Electric P8 Ultimate.

Using the "EPLAN Multiuser Management" extension module, you can divide projects into so-called "defined working sections". This makes the display of large projects more transparent and increases the editing speed. If external persons are to be used for editing extensive projects, or if editing is to be carried out independently of a network connection, you can additionally use the functionality to divide these projects into several subprojects.

Import and export of the overall configuration for defined working sections
When defining defined working sections you now have the possibility to export all the schemes created for a project as an overall configuration and subsequently for example to import them for a different project.
To this purpose you can use the two new buttons (Import) and (Export) in the dialog Define working sections as project administrator. During an import all the existing schemes are deleted and the defined working section has to be reselected or assigned.

**New features for subprojects**

The possible subprojects specified through the defined working sections are displayed in the dialog Subprojects.

An overview of the new features for this dialog:

- **Filing off projects into other directories:**
  Subprojects can now be filed off directly into a different directory. This means that you can store subprojects into separate directories and enable these directories for further editing.
  To this purpose you can use the [...] button in the new Directory column to select a different target directory. This information is then stored in the source project. The default setting here is the set project directory.
- **Updating the main project:**
  Through the new [Update] button you can update the main project, i.e.
  "store" new states of subprojects, without having to file them off again.

- **Only extend subprojects:**
  The **Only extend subproject** check box originally located below the
  table has been moved into the table so that it is now possible to specify
  these settings individually for each subproject.

**New Features in the "EPLAN User Rights Management" Extension Module**

**Note:**

The "EPLAN User Rights Management" extension module is available as
an optional extra for the following programming variants:
EPLAN Electric P8 Select, EPLAN Electric P8 Professional, EPLAN Fluid,
EPLAN Fluid Professional, EPLAN Fluid Professional E, EPLAN Pre-
planning P&ID, EPLAN Preplanning Professional, EPLAN Pro Panel Pro-
fessional Stand-alone.
This extension module is part of the delivery scope for the following pro-
gram variants by default:
EPLAN Electric P8 Professional+, EPLAN Electric P8 Ultimate, EPLAN
Pro Panel Professional+ Stand-alone.

Through the "EPLAN User Rights Management" extension module, the
rights management, an administrator can configure both the user rights and
the user interface (dialogs, menu structure, etc.) of the EPLAN platform.
**Importing Windows users and groups**

In medium-sized or large organizations the users are often managed by using Active Directory groups. Every user logs in at their workstation by using their Active Directory account (Windows user name and password).

You can now import these Windows users and groups from Active Directory in the EPLAN rights management. If such a user has been configured in the EPLAN rights management, he is logged on automatically in EPLAN, and the program is available to the configured functional scope.

---

**Benefit:**

*The simple importing of users or groups from Windows can result in a notable savings in time when working with the rights management. Through the assignment of editing rights to such an imported group all the group members receive the corresponding rights without a separate user having to be created and edited for each group member.*

---

It is mandatory for the **Log on with Windows user name** working mode to be used so that the users imported from Windows can be logged on in EPLAN.

**Import users and groups from Windows**

The button ![Import Users and Groups from Windows](image) (Import users and groups from Windows) in the dialog **Rights management** is used to import Windows users or groups from Active Directory. The button is displayed when you have marked the **User** folder on the left in the dialog **Rights management**.
In the subsequent dialog **Select users or groups** select the desired Windows user or the Active Directory group. Subsequently you carry out the assignment of the desired EPLAN routes by assigning one or more EPLAN groups to the Windows user or the Active Directory group.

For further information on this topic, please refer to the help system in the section "Importing Windows Users".
New Features for EPLAN Electric P8

Terminals and Plugs

In this version the editing of existing terminal strips and plugs has been improved and extended further. The dialog Edit plug now also provides the possibility to store the column configuration in a scheme. The internal management of multi-level terminals has been revised and optimized for Version 2.5. Since this version therefore the levels are assigned in descending order when multi-level terminals are generated in the dialogs Edit terminal strip and Generate terminals (devices). This behavior now also applies during the generation of multi-level terminals in the dialog Generate functions that you can call up via the popup menu in various navigators.

We discuss the following topics in the next sections:

- "Improvements in editing terminals" on Page "60"
- "Extensions for Main Terminals" on Page "65"
- "Direct connections between terminals" on Page "67"
- "Hidden "Connections" tab at terminals and pins" on Page "68"
- "Improvements in Working with Plugs" on Page "69".

Improvements in editing terminals

The central dialog for the editing of terminals is the dialog Edit terminal strip. Here all the data for the marked terminal strip are displayed. In this version this dialog has been extended, among other things, with new useful columns and functionalities.
New and modified columns

In the past terminals that did not match the part were identified in the Row column by a white line at the margin in the dialog Edit terminal strip. Unplaced terminals were displayed in brackets. These non-Platform-conform representations have been removed. The information is now indicated instead by means of icons known from the terminal strip navigator in the new Status column.

Benefit:

Thanks to the new columns and editing features you can configure the terminal strip without having to switch between different dialogs. The new Status column facilitates, among other things, the recognition of unplaced terminals and the assignment of suitable parts. The icons known from the terminal strip navigator are used to this purpose. In addition to the alignable accessories the non-alignable accessories are now also visible in the dialog Edit terminal strip.

Several new columns are available for display in the column configuration:

- **Status:** Indicates on the basis of the icons (as in the terminal strip navigator) whether a terminal is placed or not, whether the terminal overlays a function template of a part or whether free function templates of the part are left over. This makes it clear at multi-level terminals, for example, whether the part matches the multi-level terminal.

- **Preview accessories:** Shows a schematic preview of the non-alignable terminal accessories. In addition a Tooltip is shown. The accessory is defined through the product subgroup in the parts management.
Example:

The following illustration shows a possible column configuration for the dialog Edit terminal strip with the new columns Status and Preview accessories.

The following columns have been changed:

- **Saddle jumpers (internal) / Saddle jumpers (external):** Saddle jumper connection points and existing saddle jumpers are displayed graphically in these columns. Automatic and manual saddle jumpers are now differentiated by the color of the graphic (red = automatic, black = manual). Direct Connections between the Terminals are also displayed graphically here now (see Page "67").
Device selection

The new popup menu item **Device selection** is available in the dialog **Edit terminal strip**. The menu item is available if one main terminal is marked or if one or more levels of a multi-level terminal are marked. The selection of a suitable part for the main or multi-level terminal is possible via the subsequently opened dialog **Device selection**.

Connection-point-oriented view

The new popup menu item **View: Connection-point-oriented** is available in the dialog **Edit terminal strip**. The connection-point-oriented view shows all the connection points of the terminals, irrespective or whether connections are connected there or not. This means that additional rows are displayed for connection points to which no connection is connected. Information is thus displayed that is also available in connection-point-oriented reports.

---

**Benefit:**

The connection-point-oriented view corresponds to the connection-point-oriented reporting of the terminal strip. Free connection points to the terminal strip can be recognized immediately.
Example:

In this example four terminals with four connection points each are contained in the terminal strip – X1 – of which however the terminal connection point c is not connected. In the standard view of the dialog Edit terminal strip the unused connection points are invisible.

In the connection-point-oriented view additional rows are displayed for the unused connection points.
Swapping internal / external terminal targets for individual connection points

The new popup menu item **Connection point: Swap internal / external** is available in the dialog **Edit terminal strip**. The menu item is only available if a cell is marked in the **Terminal connection point (internal)** or **Terminal connection point (external)** column exists. Its usage mainly makes sense in the **connection-point-oriented view**.

This menu item changes the setting of the property **Internal / external** for an individual marked terminal connection point. This means that a previously internal terminal connection becomes an external terminal connection and vice versa. The internal and external terminal connections can be defined individually in the process.

In the course of this extension the existing popup menu item **Swap internal / external** has been renamed to **Terminal: Swap internal / external** for better differentiation. The menu item swaps **all** the internal and external terminal targets of the marked terminals.

For further information about these topics please refer to the help system in the section "Accessories of Terminals and Terminal Strips", and in the context-sensitive help of the dialog **Edit terminal strip**.

**Extensions for Main Terminals**

If a terminal is defined as a main terminal, then it behaves in a similar manner to a main function. Main terminals are now handled as main functions even more than in the past. To this purpose several improvements and extensions have been added for this version.
Parts at main terminals with any representation type

In the past only parts at multi-line main terminals could be selected. When changing over to a different representation type the Parts tab was hidden. A part that was entered previously at such a terminal was still assigned to the terminal, but was not reported.

Now the Parts tab is also displayed at main terminals with any representation type. A part entered there is also output in the reports (parts list).

**Benefit:**

You can enter parts in any representation type of a main terminal. A part can also be entered and reported at parts that only occur in the overview representation.

Assign main terminal

The new menu item Assign main terminal is available in the Project data > Terminal strips menu. If the same terminal occurs in different representation types, you can use this menu item to change the main terminal. This functionality is analog to the assignment of main functions. The marked terminal becomes a main terminal, the parts data are copied to the new main terminal and deleted at the original one.

Converting surplus main terminals

Surplus main terminals are corrected as well during the conversion of surplus main functions via the menu items Utilities > Synchronize > Functions > Correct main functions. If the same terminal occurs in different representation types, only one may be the main terminal. The surplus main terminals are converted into auxiliary terminals.
Allow terminals as main functions

In the past you could assign both the property Main terminal as well as the property Main function to a terminal. However, the property Main function is not required and does not make sense for terminals because the property Main terminal already ensures that the terminal behaves similarly to a main function.

Therefore the Main function check box is now deactivated and grayed out by default in the property dialog of terminals in the Symbol / function data tab.

You can, if required, restore the old behavior through a setting in the dialog Settings: Compatibility. To do so, select the menu items Options > Settings > Projects > "Project name" > Management > Compatibility and activate the Allow terminals as main function check box.

Direct connections between terminals

In the past automatic saddle jumpers or wire jumpers were generated between terminals with the connection point type "Direct connection point" if the direct connection points are connected with each other in the schematic. Now the direct connections arising between these terminals are retained.

 Benefit:

Terminals that are connected electrically by plugging together can now be designed simply in EPLAN. The connection point logic settings of the terminals taken into consideration during the jumper formation. The direct connections arising between the direct connection points are retained.
Direct connections are also displayed graphically in the columns **Saddle jumpers (external)** and **Saddle jumpers (internal)** in the dialog **Edit terminal strip**. In contrast to saddle jumpers the connecting points are represented by rectangles at direct connections instead of by circles. This representation also applies for reports.

PE / PEN terminals that are connected with each other always have a direct connection via the rail contact. Direct connections between PE / PEN terminals continue not to be displayed in the dialog **Edit terminal strip**.

**Hidden "Connections" tab at terminals and pins**

In the past the targets of terminal connections could be reported deviating from the graphic through symbol variants, connection point logic as well as the settings in the **Connections** tab (among other things the form position). The reports and the schematic deviate from each other, which does not fulfill the standard requirements for clear and unique documentation. The combinations of possibilities, in particular in connection with macros, often resulted in misunderstandings and errors.

Therefore the **Connections** tab that was displayed in the past in the property dialog of terminals and pins is now hidden and not used by default. The terminals / pins are always reported in accordance with the settings in the connection point logic. You can continue to configure all the wiring variants through the remaining settings and a unique schematic.

**Benefit:**

*The reports now always correspond to the configuration in the schematic, thus resulting in a clear and unique documentation. Handling becomes simpler, the schematic becomes clearer.*
You can, if required, restore the old behavior through a setting in the dialog Settings: Compatibility. To do so, select the menu items Options > Settings > Projects > "Project name" > Management > Compatibility and activate the Use 'Connections' tab at terminals and pins check box.

When you open projects that were created with previous EPLAN versions, the check box is activated automatically.

For more information on this topic please refer to the context-sensitive help of the dialog Settings: Compatibility.

Improvements in Working with Plugs

If you insert a plug as a device, the function definition of the respective pin is now displayed as a placement aid. You can use the [N] key to "browse" through the functions.

One of the central dialogs for the editing of plugs is the dialog Edit plug. Here all the display settings and data for the selected plug are displayed. In this version this dialog has been extended with new useful columns as well as the column configuration via scheme technology.

Scheme for column configuration and new columns

In the past you could carry out the column configuration in the Edit plugs dialog via the popup menu item Configure representation. With the new version the displayed columns and their sequence are now stored in a scheme.

To this purpose the dialog contains the new field Scheme. Here you select a scheme from the drop-down list to define the settings. Click [...] to open the dialog Settings: Column configuration. There you can edit existing schemes or create a new scheme.
Benefit:

The fact that you can store the configurations for different editing cases as schemes means that you can switch rapidly and simply between various representations of the plugs.

Several new columns are available for display in the column configuration:

- **Connection properties:** You can now display various connection properties of the connections that are connected to the pins as columns. These properties, for example the **Connection color / number** or **Connection cross-section**, can be displayed separately for the male pin end and the female pin end of the plug.

- **Part number:** You can display up to ten parts assigned to the pin in the columns **Part number [1] - Part number [10]**. A part selection is possible through the [...] button within a field.

In addition the fields of the columns **Function definition (...)** that in the past served only to display the data and were therefore grayed-out, can now be edited. Whether the function definitions of the male pin end or of the female pin end can be edited depends on the respective plug definition. When changed, the corresponding data are written back to the schematic.
Cables

Displaying the source and target of the cable

In the past if you wanted to display the source and target of a cable in the schematic, this was only possible through the display in the cable DT. To this purpose you have to specify a corresponding format for the cable numbering.

Now the source and target of the cable are displayed in the schematic through the new properties **Cable: Source** (ID 20376) and **Cable: Target** (ID 20377). These properties can also be used in the block properties, during external editing and in reports.

---

**Benefit:**

*The source and target of the cable can be displayed independently of the cable numbering. By means of block properties you can, for example display the source and target together or display additional texts before the property values.*
New Features in the "EPLAN PLC & Bus Extension" Extension Module

Note:

The "EPLAN PLC & Bus Extension" extension module is available as an option for EPLAN Electric P8 Select. This extension module is part of the standard scope of delivery for EPLAN Electric P8 Professional, EPLAN Electric P8 Professional+, and for EPLAN Electric P8 Ultimate.

The "EPLAN PLC & Bus Extension" extension module helps you to design PLC controllers and bus systems.

Extensions for network connections

To represent bus and network connection points in EPLAN, the function definitions of the category "Network / bus cable connection point" are available.

In the new version the network connections of the Ethernet-based bus systems are now compatible with each other:

- EtherCAT
- Ethernet
- EtherNet/IP
- Powerlink
- PROFINET.
Benefit:

The fact that the network connections are compatible for specific bus systems means that it is possible to map switchable network interfaces that can, for example, be used alternatively in an Ethernet or PROFINET bus system.

Improvements in the importing of bus configuration files

Compatible bus systems taken into consideration

During the import of bus configuration files in the past the connection points from the import file were only assigned to the connection points in the project if the bus systems were identical. If this was not the case, new additional PLC connection points were generated during the import. The connection points are now also assigned when the bus systems are compatible. This means that less additional PLC connection points arise during importing.

Supporting of placeholder characters during the part allocation

The bus configuration files can contain similar devices that only differ in certain characteristics, such as their use in different environmental conditions. The programming of the PLC software is identical for these devices. Only the part to be used respectively differs depending on the field of use. The order numbers, type designations or similar data of these parts often only differ in one or a few positions. Placeholders such as "*" and "?” are often to this purpose in the bus configuration files of various manufacturers.

During the import these data are compared with the PLC type designation - depending on the selected format. If several parts with suitable PLC type designations are found in the parts database, the first one found is assigned automatically. The new check run 004057 can be used to find the corresponding functions in order to assign these to a different part.
Keeping Line Breaks when Importing Assignment Lists

An assignment list contains the addresses, the symbolic addresses, and the function text of a PLC. They are available in different formats, according to the manufacturer. During an export from EPLAN the line breaks in the function texts are removed at the majority of formats, since line breaks are not foreseen in the corresponding PLC configuration programs.

In the past the function texts were transferred in unchanged form – i.e. without line breaks – from the import file into the dialog Import / synchronize assignment list during an import. Before the changes were applied you could restore the line breaks existing in the project by using a popup menu item, provided the function texts were otherwise unchanged.

You can now decide directly at the import whether the line breaks existing in the project are to be kept or not. The new check box Keep line breaks in the project is now available in the dialog Import / synchronize assignment list to this purpose.

**Benefit:**

Line breaks in the function texts can already be taken into consideration during importing and do not have to be corrected in a subsequent step. This means that less changes are displayed in the dialog Addresses / assignment lists and the relevant changes can be recognized more easily. It is no longer so easy to delete the line breaks in the project unintentionally.

The popup menu item in the dialog Addresses / assignment lists for subsequent correction of the line breaks continues to be available and has been renamed to ensure consistency:
<table>
<thead>
<tr>
<th>Old designation</th>
<th>New designation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Adopt line breaks</td>
<td>Keep line breaks in the project</td>
</tr>
</tbody>
</table>

For more information on this topic please refer to the context-sensitive help of the dialog **Import / synchronize assignment list**.

**Display of the determined symbolic address in the assignment lists**

In the past only the properties **Symbolic address** and **Symbolic address (automatic)** were available for display of the symbolic address in the dialog **Addresses / Assignment lists**. Now the property **Symbolic address (determined)** can be displayed additionally in the table area **PLC data from schematic**. To this purpose you can carry out a configuration of the columns as you are used to by using the popup menu item **Configure representation**.

The **Symbolic address (determined)** property (ID 20403) shows the symbolic addresses determined through the target tracking. The determined symbolic address can also be output during the export of assignment lists. Since this is an automatically filled property, it is not taken into consideration during the import.

**Additional format elements for assignment lists**

It is necessary to set the correct format of the assignment list for the import and export of assignment lists. These settings are carried out in the dialog **Settings: PLC-specific** in the **Format of assignment list** tab as well as in the dialog **Row formatting in assignment list** that you access from this tab.
The following new format elements are available in the dialog **Row formatting in assignment list** to edit the format of the PLC addresses in the assignment list rows:

- **Symbolic address (determined):** Displays the symbolic address determined via the target tracking, i.e. the connected DT. By contrast the familiar "Symbolic address" format element shows the manually entered symbolic address (if it exists) or otherwise the determined symbolic address.

- **Ignored text:** The "Ignored text" format element is needed in order to import assignment lists in which components occur for which EPLAN does not find any correspondence and that can therefore not be written into any EPLAN property during importing. The corresponding components of the assignment list row are ignored during importing and are not available in EPLAN.
  
  During exporting an empty entry is generated in the export file for each "Ignored text" format element.

  Ignored texts always have the length "Infinitely variable".

**Benefit:**

*The connected DT can be exported together with the manually entered symbolic address by means of the "Symbolic address (determined)" and "Symbolic address" format elements during the export of assignment lists. Assignment lists that contain components that cannot be processed further in EPLAN can be imported by means of the new "Ignored text" format element.*

For more information on this topic please refer to the context-sensitive help of the dialog **Row formatting in assignment list.**
PLC Connection Points with Fixed Addresses

If you use PLC connection points with fixed addresses in your project, these should normally not be modified during subsequent addressing or during the insertion of macros. With the new property **Do not include in addressing** (ID 20380) you can specify at a PLC connection point that it is to be excluded from addressing and thus always retain its original address. During addressing such PLC connection points are also not displayed in the result preview.

**Benefit:**

*Fixed hardware addresses are not modified automatically.*
New Features for EPLAN Pro Panel

Thermal Design Integration

*Thermal Design Integration* is a concept for supporting the thermal design of switch gears:

- Virtual planning and dimensioning of energy-efficient climate control solutions
- Validation of mounting layouts.

*Thermal Design Integration* makes available functionalities, extended product data, sets of rules and software-based decision-making tools to support the planner and to validate the planning results:

- Determination of the total power dissipation of all the devices
- Visualization of the power dissipation density in order to avoid hot spots
- Determination of the power dissipation layout for optimal configuration of the components in the enclosure
- Interface to Rittal Therm for designing and dimensioning the climate control component
- Optional: Utilization of the extended Rittal parts data for climate control solutions via the EPLAN Data Portal
- Optional: Representation of the optimal air-conditioned area per climate control component in which the components are to be laid out in the enclosure
Optional: Airflow-specific reserved areas per climate control component for optimizing the cooling air circulation and for protecting the components against overheating or undercooling

Optional: Airflow directions of climate control components.

**Benefit:**

*Through the combination of these planning and decision-making tools the following aims are achieved:*

- Simple planning and energy-efficient thermal design of climate control solution
- Taking into account of the rules for correct mounting layout of the components
- Ensuring of fault-free operation of machines and plants
- Simple planning and energy-efficient design of climate control solutions
- Norm-compliant project planning to IEC 61439 "Ensuring of fault-free operation".

**Notes:**

- The concept is based, among other things, on parts data of the manufacturer Rittal which will be available as of September 2016 (release of Version 2.6) in EPLAN Data Portal.
- Usage of the views "Airflow directions", "Optimally air-conditioned areas" and "Airflow-specific reserved areas" furthermore requires licensing / validation by Rittal. Registration and validation are effected via Rittal and are possible as of the release of EPLAN Platform 2.6 in September 2016.
We discuss the following topics in the next sections:

- "Views for the Thermal Design" on Page "80"
- "Checking the Uneven Power Dissipation Layout in an Air-conditioning Field" on Page "82".

Views for the Thermal Design

In the context of the planning of switch gears with EPLAN Pro Panel several special views have been developed for the "Thermal design".

**Benefit:**

The views for the "thermal design" support the plant designer in planning the most efficient climate control solution possible.

Views only for Rittal climate control components:

- Airflow directions
- Optimally air-conditioned areas
- Airflow-specific reserved areas

Views for all devices and terminals:

- Power dissipation density.

**Note:**

The "power dissipation density" view is available for all devices and terminals when the Max. power dissipation part property contains a value. Usage of the views "Airflow directions", "Optimally air-conditioned areas" and "Airflow-specific reserved areas" furthermore requires licensing / validation by Rittal.
All views are activated and deactivated in the View menu via the new menu item Thermal design.

Airflow directions
In order to follow the course of air flows during planning, the direction of the cold-air and hot-air flows at the Rittal climate control components can be represented by means of airflow direction arrows. The airflow directions show the type and direction of flow of the incoming and outgoing air flow at the respective outlet opening:

- Cold airflow (blue)
- Warm airflow (red).

If the parts macros provided with airflow directions are placed in the layout space during project planning, the airflow directions can be displayed.

Optimally air-conditioned areas
The optimally air-conditioned area describes the area that a Rittal climate control component can reliably air-condition on the basis of its air circulation capacity.

The so-called "reach" of the cold air of the climate control component is decisive for the extent of the optimal air-conditioned area. Components that produce exhaust heat should preferably be laid out in this area.

Note:
The reach of the climate control component is a theoretical value. Influencing of the air flow by components or enclosure parts is not taken into consideration.
Airflow-specific reserved areas

Airflow-specific reserved areas are defined by the manufacturer of the parts data at the part. Reserved areas describe the area that has to be kept free of obstacles in order to achieve complete efficiency of the air-conditioning effect.

Power dissipation density

The "power dissipation density" view is available for all devices and terminal strips when the Max. power dissipation part property contains a value. In order to already find possible hot spots that arise through unfavorable item placement during the design phase, the respective part placements can be represented by a coloration in five different colors. The power dissipation density of a component is relevant for the representation. The power dissipation density results from the Max. power dissipation part property of a component in relation to the surface of the part placement.

Further information about this topic is available in the help system in the section "Views for the Thermal Design".

Checking the Uneven Power Dissipation Layout in an Air-conditioning Field

The even distribution of the power dissipation within an air-conditioning field (enclosure) is particularly important for the thermal design of switch gears. The power dissipation center in the air-conditioning field can be determined in order to avoid unequal distribution of the power dissipation and thus the formation of hot spots. To this purpose the new check run message 026099 is available in the message class 026 "3D mounting layout". At a corresponding check run the air-conditioning field is divided virtually into an upper and lower half and a calculation is carried out in which half a significantly higher power dissipation exists (>=25%).
As a result of this test the layout of the affected part placements should be changed so that the power dissipation is distributed evenly in the complete air-conditioning field so that reliable air-conditioning is possible. A further possibility is the insertion of accessories for air guidance at the climate control component.

**Benefit:**

_The plant designer can establish during the designing stage whether the power dissipation layout in an air-conditioning field is uneven and where the power dissipation center lies. The results of the check help in ensuring even distribution of the components, in avoiding hot spots and in optimizing the climate control._

Further information about this topic is available in the help system in the section "Determining Unequal Power Dissipation Layout in an Air-conditioning Field".

**Routing of Hydraulic Hose Lines and Pipings**

The free routing of connections has been extended so that you can now also route and design hose lines and pipings in 3D mounting layout at 3D fluid designing. For further information on this topic, see the sections "New Features for EPLAN Fluid" (see Page "108") and "Routing Preconfigured Hose Lines" (see Page "110").
Collision Check for Freely Routed Routing Connections

The message management has been extended by the new check run message 026089 for determining collisions of routing connections in the layout space in the message class 026 "3D mounting layout". The collision of a connection routed freely in a layout space with another freely routed connection or with a part placement is checked.

The extended collision check checks all the electrical engineering and fluid power connection types that are routed freely (meaning that they are not routed in wire ducts).

**Benefit:**

*Electrical engineering and fluid power connections can be planned in 3D, documented, manufactured and installed without collisions.*

Exchanging Enclosure Parts

In 3D mounting layout it is now possible to exchange the part of an enclosure without part placements existing in the original enclosure having to be deleted. This can be necessary if the 3D graphical macro has been revised or if a larger or smaller enclosure is required for the existing mounting layout. As a result of the exchange the 3D graphical macro of a 3D part placement (enclosure) is replaced by that of the other part.
Benefit:

The exchange of the part allows enclosures to be replaced by other enclosures in a single pass. It is no longer necessary to search for, delete and once more place all the existing 3D graphical macros in the layout space. Whenever the exchange of an enclosure housing is required, this functionality saves a great deal of time.

To this purpose the new menu item Exchange parts is now available in the popup menu of the layout space navigator for enclosures.

The following conditions apply when an enclosure part is exchanged:

- All the properties as well as the existing equipment of the original enclosure are applied completely and graphically unchanged. The accessories of the original enclosure are applied if these also exist as accessories of the new enclosure. Accessories that were not applied have to be inserted manually by the user.

- Differences that occur after the exchange (for example by modified size ratios or gaps in a line up) have to be corrected by the user.

- Objects that cannot be placed in the new enclosure are displayed on the "Incorrectly placed" hierarchy level directly under the "Enclosure" hierarchy level. These objects can be placed manually by the user on a mounting surface of the new enclosure.

For further information on this topic, please refer to the help system in the section "Exchanging Parts (Enclosure)".
Updating the Part Placement

In the past the popup menu item Update part dimensions in the layout space navigator was used to update the values for width, height and depth at the part placement after a part change. In the current version this popup menu item has been replaced by the new popup menu Update part placement with the extended functional scope.

When this menu item is selected, a macro stored at the part is also taken into consideration in addition to the part dimensions at a part modification. If you have carried out modifications at the macro, for example have entered an additional mounting point, base point or mounting surface, the old macro at the part placement is replaced by the modified or new macro and thus the display adapted. Multiple selection is possible.

**Benefit:**

Through the popup menu item Update part placement graphical and logical modifications to the macros stored at the part are transferred simply to part placements without your having to delete the part placement and replace it. This means an enormous saving in time during the exchanging of a part or during the updating of a part placement because the parts data and the 3D geometry correspond.

**Note:**

The Update part dimensions popup menu item in the dialog 2D panel layout - <Project name> continues to exist, the Update part placement popup menu item is no longer available here.
For further information on this topic, please refer to the help system in the section "Updating Part Placements".

**Extensions when Placing Parts**

**Using length-variable items as "prefabricated" parts**

In EPLAN Pro Panel it is now also possible to define all length-variable items (wire ducts, mounting rails, etc.) as parts with a predefined length. To this purpose you create a 3D macro in the 3D view of the respective item with a specific length and store it at the part. In this form the part is then used as a "prefabricated" item with predefined length.

When creating the 3D macro an individual handle can be defined (for example on the center of the first drill hole). If such a part is placed, the handle of the macro is available as an additional user-defined handle. This allows length-variable items to be placed at defined target points (such as existing drill holes on the mounting panel).

**Benefit:**

*Length-variable items with a defined length can now also be installed at predefined points in automatically created mounting structures (EEC / EEC One).*

**Multiple placement of parts without gaps**

Parts that in reality latch in positively during adjoining were in the past always placed with a gap during multiple placement in EPLAN Pro Panel. This gap between each part placement is now avoided automatically.
**Benefit:**

*Manual revision work at adjoined part placements is now no longer required.*

**Display and Management of Mechanical Devices in Navigators**

Placed and unplaced mechanical devices are now displayed in the device navigator, navigators derived from it and the 3D mounting layout navigator. Mechanical devices dispose of a function definition from the "Mechanics" trade and can be placed as 3D part placements in the layout space.

- **Tree view of the device navigator:**
  The individual functions are represented below the mechanical device (for example enclosure, mounting panel, mounting rail, etc.; icon ✅). In the case of a corresponding assignment (for example to a terminal strip) mechanical functions are also displayed in the other project data navigators.

- **Tree view of the 3D mounting layout navigator:**
  As usual mechanical devices that are already placed are identified by a special icon (✅).

**Note:**

Mechanical devices are not displayed in the 2D panel layout navigator.
Unplaced mechanical functions

In the course of this change it is now also possible to generate mechanical functions as unplaced functions (for example by deleting a placement).

Mechanical devices with unplaced mechanical functions behave like a device group during deleting and placing. If an unplaced function is deleted in the device navigator, the entire device is removed. When placing from the navigator all the functions are placed together in an opened layout space – irrespective of the selection made. Placing is possible, for example, via Drag & Drop from the device or 3D mounting layout navigator.

New devices with unplaced mechanical functions can now also be generated in the device navigator by means of the popup menu item New device. Mechanical functions cannot be created by using the popup menu items New and New functions because mechanical functions without parts do not make sense.

During the import of devices via the menu items Project data > Devices > Import devices with unplaced functions arise in the project. Whether logical (electrical-engineering or fluid-power) or mechanical devices are generated depends on the respective assigned parts. Imported mechanical parts are now displayed as unplaced mechanical functions and in the 3D mounting layout navigator as unplaced 3D part placements.
Benefit:

All devices (also mechanical ones) can now be imported directly as devices and – in the case of assigned parts with the required information – can be placed via the device or the 3D mounting layout navigator in the layout space. Working with mechatronical device lists (DTs, part numbers) is now supported consistently in the corresponding navigators and in the project.

Support of the mechatronical design in accordance with DIN EN 81346, including mapping of the complete device structure for reference identification in the project and in the navigators.

Parts with mechanical function definitions are now converted into part placements in the case of placement on a mounting panel in the 2D panel layout.

Standardized and Automated Creation of Manufacturing Drawings

You can use model views, 2D drilling views and copper unfolds in EPLAN Pro Panel as views for representation and for drawing generation. Additional information such as dimensions, texts, etc. can be assigned to the views for manufacturing.

With the cut-out legend a new report for the 2D drilling views is now available as of Version 2.6. In addition updating of model views has been accelerated.
New Report "Cut-Out Legend" for 2D Drilling Views

The drilling view (2D) is a form of model view specialized in the display of NC-relevant data. It is possible to generate reports for the cut-outs displayed in the 2D drilling views.

**Benefit:**

*It is possible to report the NC-relevant cut-outs displayed in the 2D drilling views through the usage of the "Cut-out legend" report. The most important data of these manually inserted cut-outs or cut-outs imported from drilling patterns can be displayed in a table. As for each report the cut-out legend can be created automated and standardized. This furthermore ensures a maximum of clarity.*

The new report type "Cut-out legend" is available to this purpose in the dialog **Select report**. Analog to the enclosure legend a cut-out legend can be output as a new report page or be placed manually as an embedded report in an existing project page.

In the reports of this type the most important data of the cut-outs are listed in a table (for example item designations such as the respective drilling type "Drill hole", "Rectangle", "Slotted hole" etc., X , Y coordinates of handles, size of the cut-out, etc.). Corresponding forms are supplied for this new report in the master data (see Section "Master Data: Forms and Plot Frames" on Page "138").
Renamed properties

In order to make clear that the two properties Legend form and Suppress generation of legend are only relevant for the generation of enclosure legends, these have now been renamed:

<table>
<thead>
<tr>
<th>Old designation</th>
<th>New designation</th>
<th>ID</th>
</tr>
</thead>
<tbody>
<tr>
<td>Legend form</td>
<td>Enclosure legend form</td>
<td>20440</td>
</tr>
<tr>
<td>Suppress generation of legend</td>
<td>Suppress generation of the enclosure legend</td>
<td>20441</td>
</tr>
</tbody>
</table>

Accelerated Updating of Model Views

When reports of the "Model view" type are updated, an extensive calculation of the hidden edges is carried depending on the specified properties for the view (for example basic items, style, etc.). This means that updating may take some time, especially at projects that contain many items and a large number of model views.

Through the combination of various optimization measures the time required for updating has been reduced by 40% in Version 2.6.

Housing Configuration With the New Rittal Configuration System Configurator

A link to the new configurator Rittal Configuration System allows the user to call up the configurator from the EPLAN Data Portal and to configure an AE, KL or EB enclosure including accessories intuitively, simply and correctly.

The result of the configuration - the 3D enclosure model - can be placed directly in an opened layout space for further use in EPLAN Pro Panel.
Benefit:

The link with the Rittal Configuration System allows the integration of the Rittal system know-how in the engineering workflow, a correct mounting layout and structure of an AE, KL or EB enclosure system as well as the direct application of the configuration.

Extension of the File Format for the Publishing of Projects

The EPDZ format that is used to publish projects through the menu items **Project > Publish** has been extended by data about 3D routing connections. These data can then be displayed and processed in the production via the new browser-based software solution *EPLAN Smart Wiring*. The digital representation in this software solution directly references the 3D layout in EPLAN Pro Panel. For further information about EPLAN Smart Wiring please refer to our Website.

Renamed Interfaces for Exporting Manufacturing Data

As a result of the integration of the Kiesling company into Rittal Automation Systems two optional interfaces for exporting manufacturing data have been renamed:

<table>
<thead>
<tr>
<th>Old designation</th>
<th>New designation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Automatic equipment (Athex)</td>
<td>Automatic equipment Rittal - Athex</td>
</tr>
<tr>
<td>NC Kiesling</td>
<td>Rittal - Perforex / Secarex</td>
</tr>
</tbody>
</table>
- **Interface "Rittal - Athex":**
  Alls the output of data for the automatic placement of terminals on mounting rails. The "EPLAN Pro Panel Production Rittal - Athex" extension module has to be licensed to this purpose.

- **Interface "Rittal - Perforex / Secarex":**
  Allows the output of manufacturing data to NC-supported machines. The output format of this interface supports the drilling and milling machines of the Perforex series and the Secarex cutting center. The "EPLAN Pro Panel Production Rittal - Perforex / Secarex" extension module has to be licensed to this purpose.

The associated dialogs and their menu paths have been adapted correspondingly (for example Utilities > Manufacturing data > Automatic equipment Rittal - Athex).

**Note:**

The "EPLAN Pro Panel Production Rittal - Athex" and "EPLAN Pro Panel Production Rittal - Perforex / Secarex" extension modules are available as an option for EPLAN Pro Panel Professional and EPLAN Pro Panel Professional+.
New Features for EPLAN Preplanning

Extended Configuration of Segment Definitions

Multiple selection of segment definitions
A multiple selection of segment definitions is now also possible in the tree view of the dialog Configure segment definitions.

**Benefit:**
Segment definitions can be configured faster and more comfortably by means of a multiple selection.

You can carry out various configurations for several segment definitions (for example display name, write protection, etc.) simultaneously. Other functionalities – such as the creation of new segment definitions or the configuration of the segment properties – are not possible at a multiple selection and are grayed-out in such a case.

In the past all the segment definitions were always exported during the export of segment definitions. Through the multiple selection you can now also export selected segment definitions specifically and subsequently import them.

Configuring the availability of tabs in the pre-planning
During the configuration of segment definitions you can now specify which tabs are to be available at the segments for the entry of data (for example PLC, Macro).
Benefit:

With the Available data settings you can configure the segments so that only the required data are displayed. This way you can hide the tabs PLC and Macro for example at planning objects that do not have macros of PLC inputs.

To this purpose the table Available data was added to the existing tab Write protection of the dialog Configure segment definitions and renamed to Availability. The tabs that are available for the input of data at the segments are listed in the new table Available data.
Through a check box in the **Display** column you specify for selected segment definitions which tab are displayed for the input of data at the segments. If tabs are not available on principle for the respective segment definition, the corresponding rows are grayed out.

**Note:**
If data are stored at a segment in a tab, this tab is displayed even if the display in the **Available data** table is activated.

**PCT loops insertable below planning objects**

PCT loops may now also be inserted below planning objects – at a corresponding configuration. The **Configure segment definitions** dialog has been extended for this purpose. For loops and consumers you can now also select the segment definitions for planning objects in the **Can be inserted in** field.

**Copying settings for segment properties**

In the pre-planning it is important that values be assigned individually and explicitly to certain properties by the user. For this reason you can now specify during the configuration of the segment definitions whether the values of user-defined properties are to be included in copying.

The **Segment properties** tab of the dialog **Configure segment definitions** has been extended to this purpose. Through a check box in the new **Copy** column you specify for the selected segment definition whether the value for the respective user-defined property is to be included in copying when a project is copied (check box activated) or not (check box deactivated).
Extensions for PCT Loops and P&I Diagram

Improved selection of structures

The dialog Select structure can be used to sort PCT loops / PCT loop functions when inserting them into a P&I diagram in the existing structure of the project. In the process you insert these objects either through the symbol selection, as copies from the Clipboard, or by means of macros that contain P&I diagram sections.

In the current version the selection in this dialog has been simplified and improved at several points:

- **Multiple selection:**
  Multiple selection is now possible in the respective tree both in the Source field and in the Project field. This allows you to move several objects simultaneously to the other side. You can furthermore use the new tab List in the Source field for rapid and targeted selection – also of several PCT loops or PCT loop functions.

- **Improved user interface:**
  In the past the same button (.undo) was used for assigning and "undoing". The new button (Assign) is now available for assigning segments.

- **New popup menu items for segments:**
  The two popup menu items New structure segment and Properties are now available for the segments in the Project field in order to create new structures and edit existing structures when inserting PCT loops / PCT loop functions. The popup menu item New structure segment is only active for structure segments.

- **Unique numbering:**
  A unique number is now always assigned to PCT loops / PCT loop
functions during numbering in this dialog. How the PCT loops / PCT loop functions are numbered is now visible immediately - you no longer have to wait until the dialog has been confirmed. The numbering of a sorted PCT loop / PCT loop function can still be edited subsequently in the Project field by using the popup menu item Properties.

**Subsequent Numbering of PCT Loops**
In the pre-planning it is now possible to renumber the PCT loops selected in the navigator. You can use the new popup menu item Number PCT loops in the pre-planning navigator to this purpose. The settings of the dialog Settings: Numbering / PCT loops are used in the process. (The menu path for this existing settings dialog is: Options > Settings > Projects > "Project name" > Pre-planning > Numbering / PCT loops.)

**Benefit:**
The popup menu item Number PCT loops allows you to number selected PCT loops subsequently and thus close "gaps" in the numbering.

**Placing Structure Segments on P&I Diagrams**
Structure segments can now be placed as structure boxes on pages of the "P&I diagram" page type.

**Benefit:**
You can visualize the structures in the P&I diagram by placing structure segments as structure boxes. You then see immediately which apparatuses and machines drawn in the P&I diagram belong to which structures.
To this purpose you drag & drop a structure segment from the pre-planning navigator onto a P&I diagram. In the process a reference is generated to the structure segment and this reference is placed as a structure box on the P&I diagram. The structure identifiers of the structure segment are transferred to the structure box. The associated structure box is displayed in the pre-planning navigator below the referenced structure segment (icon).

The following is possible:

- The properties of the referenced structure segment (and of any superior structure segments) can be displayed at the structure box on the P&I diagram page. To this purpose the source objects "Segment" and "Structure segment hierarchical" are available in the dialog Property selection.

- A structure segment can be placed several times in the P&I diagram. Depending on the layout of the apparatuses and machines drawn in the P&I diagram that belong to the same structure you can either draw a structure box around all the objects or several structure boxes with the same DT around the individual objects. As usual a structure box can also be drawn as a polygon in the process.

- You can jump from the structure box displayed in the pre-planning navigator to its placement on the P&I diagram page via the popup menu Go to (graphic).

- The Reorganize structure popup menu item in the pre-planning navigator transfers a modified structure to the placed structure boxes as well.
Displaying the visible designation at PCT loops

The new property **Designation (visible)** (ID 44065) allows you to have a "reduced" designation displayed at the PCT loops / PCT loop functions which are placed in a structure box. In this property the designation of the superior structure box is abbreviated, meaning that the partial structure in which the PCT loop / PCT loop function is located is displayed.

If a PCT loop / PCT loop function belongs to a different structure, a "reduced" designation is displayed. In this case a ">" is displayed before the designation.

Pre-planning Navigator

Display of objects no longer assigned from the detailed planning

When segments were deleted in the pre-planning in the past, it was subsequently no longer possible to find the previously assigned objects from the detailed planning. In order to ensure that the objects no longer assigned can still be found and edited later on, all the objects from the detailed planning (pages, functions, etc.) with deleted segments are displayed below the new node "Non-assigned detailed planning" (icon ![icon](image)).

**Benefit:**

*The displaying and finding of objects no longer assigned from the detailed planning make it possible to delete the segments of the pre-planning and to revise the associated detailed planning later on.*
In the pre-planning navigator these objects that are not assigned do not have any properties. Through the popup menu item Go to (graphic) you have the possibility to branch to the schematic and there to edit the detailed planning. The popup menu items Disconnect and Delete can furthermore be used to remove the assignment to the pre-planning or to completely delete the object no longer assigned.

In order to find such detailed planning objects we have now made available the new check run message 028024 "The pre-planning assigned to the object has been deleted" in the message class 028 "Pre-planning".

**Improved sorting of the segments in a tree**

In the past the segments in the tree of the pre-planning navigator were sorted within a structure in accordance with their designation. With the new version sorting of the segments is carried out by default first in accordance with their basic definition and then their designation. The sequence of the basic definitions is:

- Structure segments
- Containers
- PCT loops
- PCT loop functions
- Planning objects.

In the case of PCT loops only the identifying components of the designation are taken into account for sorting, and not the full designation. You specify the properties that are identifying in addition to the number in the dialog Settings: Numbering / PCT loops. If, for example, the measurand is to be identifying additionally, the PCT loops are first sorted by the assigned identifier for the measurand and then by the number.
Using the arrow buttons, you can modify the sorting of the segments below a node in the tree structure. This manual sorting takes precedence.

**Creating the Pre-planning**

**Improvements in the importing of pre-planning data**

When creating the pre-planning you can import lists with pre-planning data that were created in external applications. The following new features are available for importing pre-planning data via the menu items *Project data > Pre-planning > Import*:

**In the dialog "Import pre-planning data"**:  
- "New check box "Delete missing objects in the project during re-import"":  
  If this check box is activated, segments that are missing during a renewed import in the data source, i.e. were removed, are displayed in the subsequent dialog *Synchronize pre-planning data* and by default deleted in the project. If the check box is deactivated, the segments that were removed in the data source are retained in the project.

**In the subsequent dialog "Synchronize pre-planning data"**:  
- *New status icon and new "Delete" action*:  
  Segments that are missing during an import in the data source and are only contained in the project are – if the check box described above has been activated – displayed in the dialog *Synchronize pre-planning data* as a line without property values and are identified in the Status column as deleted by means of the new icon ✗. By using the new action "Delete" these segments are deleted in the project.
Identification of changed property values:
At segments that exist in both the data source and in the project changed property values (such as a different part number) are now highlighted. Fields with changed property values have a dark-gray background. It is irrelevant the values were changed in the data source or in the project.

Creation of Schematics from the Pre-Planning

Taking into account only structure identifiers of the structure segments when generating the schematic
Since Version 2.5 it is possible for placeholder objects to have a deviating structure from the superior segments. Assigning of the deviating structure identifiers is effected by means of special properties (for example Mounting location (single component)).
If you drag & drop such planning objects with assigned macros into the page navigator in order to generate schematic pages, the deviating structure identifiers of the planning object were transferred to the generated pages and thus also to all the functions placed on these pages in the past. In order to avoid this in future the new check box **Take into account only structure identifiers of the structure segments** is now available in the general settings for the pre-planning (menu path: Options > Settings > Projects > "Project name" > Pre-planning > General).

When this check box is activated, the individual components of the planning objects are *not* transferred to the structure identifiers of the page(s) to be created. Only the structure identifiers of the *structure segments* are relevant for the structure identifiers of the pages. In this case the individual components of the structure identifiers of a planning object are only transferred to the function for which a function template is stored at the planning object.

When this check box is deactivated, the individual components of the planning objects are transferred to the structure identifiers of the page(s) to be created. *All* the structure identifiers of the structure segments and of the planning objects are relevant for the structure identifiers of the pages. This has the effect that the individual components of the structure identifiers of a planning object are also transferred to all the functions placed on the page.
Conditional Forms for all Pre-planning Form Types

The EPLAN platform gives you the possibility to define "sub-forms", which can be attached to conditions, in the case of dynamic forms at form editors. This produces a so-called "main form" and the "conditional forms" assigned to it. The conditional forms must be the same form type as the main form.

The usage of conditional forms has been possible for some time in pre-planning at the forms for overview reports (for example the form type "Pre-planning: Planning object overview" (*.f40)). Conditional forms are now also supported at the forms for the function-specific reports of pre-planning:

- Pre-planning: Planning object plan (*.f41)
- Pre-planning: Segment template plan (*.f43)
- Pre-planning: Structure segment plan (*.f39).

**Benefit:**

*The usage of conditional forms in the pre-planning offers you many more report options (such as the automatic generation of different data sheets for differing loops or for example different graphical representations for different device types). The pre-planning data can be customized must better to the requirements in the reports.*
Example:

You use a dynamic form for a PCT loop diagram as the main form (form type "Pre-planning: Planning object plan" (*.f41)) and define different sub-forms for sensor data of pressure, flow or fill level sensors for it. During a report generation the data of a PCT loop are then listed in the PCT loop diagram (meaning in the main form), and the device data of the sensors are listed in the sub-forms suitable for the device type.

Segment Templates

Displaying property values from segment templates

In the past the property values entered at a segment template were transferred to a segment when a template was selected, but were not displayed. During the selection of or a change in the a segment template the property values of the new segment template are now also displayed directly in the property dialog of the segment.

Displaying the Description in the Segment Template Navigator

In order to better differentiate segment templates the description of the segment template is now displayed additionally (behind the identifying name in brackets) in the tree view of the segment template navigator for a segment template.
New Features for EPLAN Fluid

Pipings in a Layout Space

Connections from fluid power planning can be routed freely as pipings in the layout space. The freely routed pipings can be represented in model views together with the fluid items and screw connections. A new interface is available for the transfer of manufacturing data of the pipings routed in the layout space.

Benefit:

*The new functionalities for pipings allow fluid-power pipings to be integrated continuously into the engineering and manufacturing phases from the planning in the fluid power schematic through routing and optimizing in the layout space up to exporting of the manufacturing data.*

You can subsequently change the routed pipings graphically or through keyboard entries. To this purpose individual segments can be moved, extended or shortened within the 2D plane or orthogonally. In order to adapt the form of a pipe to the installation situation you can furthermore edit the automatically generated piping elbows contained in the pipe (move, change the bending radius, insert additional piping elbow or delete them). To this purpose you can use the existing menu items **New bending position** and **Modify bending positions** as well as the new menu item **Delete bending position** in the menu item **Edit > Graphic**.
Example:
The following figure shows a model with a freely routed piping.

Generation of manufacturing data
After the free routing and customizing of a piping the next step is to transfer this piping to the manufacturing and to bend it with a pipe bending machine. A new interface is available for this purpose. EPLAN generates an XML file with the required data per piping for the transfer to the software of the pipe bending machine.

The sawing length and the bending data of a pipe are calculated with the software of the pipe bending machine. Subsequently the manufacturing data for pipe bending are transferred from the software to a pipe bending machine. For further information on this topic, please refer to the help system in the section "Pipings in a Layout Space".
Routing Preconfigured Hose Lines

Hydraulic hose lines that are planned in the fluid power schematic and have been preconfigured in the hose line configurator (EPLAN Fluid Hose Configurator) can now be routed freely during 3D fluid power project planning in the layout space.

The following is possible:

- Route pre-configured hose lines and automatic placement of the fittings in the opened layout space.
- Change the hose line course and thus change the hose line lengths. To this purpose new control points can be inserted along the course.
- Display the hose lines in model views.

The hose line lengths determined during routing are written back to the hose lines.

**Benefit:**

*With these new functionalities for preconfigured hose lines the 3D fluid configuration has been extended by hydraulic hose lines including the fittings.*
Example:

The following figure shows a model with a freely routed preconfigured hose line.
Checking the Connection Dimensions at Fluid Power Connections

The message management now offers you the possibility to compare the connection dimensions of fluid power connections with the connection dimensions of the connected functions. To this purpose the following check run messages in the message class 005 "Connections" are available:

- Message 005086 "Different connection dimension '%1!s!' / '%2!s!'"
- Message 005087 "Direct connection: Different connection dimension '%1!s!' / '%2!s!'".

**Benefit:**

*The new check runs and functionalities allow the connection dimensions to already be checked during the engineering. This eliminates unpleasant surprises during mounting for the case that the connection point data do not match there because incorrect devices were selected.*

After a corresponding check run the first message in the message management is displayed, if the value of one of the two connection dimensions at the connection or at the hose line does not match the connection dimension of the source or target function. This allows you, for example, to determine whether the air hose used is suitable for the selected push-in fitting or whether the pre-fabricated hydraulic hose line is suitable for connecting the downstream cylinder.
The *second message* is output if different connection dimensions occur at a direct connection. Such connections are used, for example in the pneumatics in a fluid power schematic for connections that run between a valve and a silencer. During this check the values of the connection dimensions at the functions connected to the source and target ends are compared directly with each other.

**Tip:**

In addition to these two check run messages the new check run message 501022 is available in the message class 501 "Part master data". This check run can be used to check in the part master data whether the connection dimensions of the function templates match the connection dimensions at the connection point pattern.

**Connection dimension at the functions / connections in the graphical editor**

The check runs 005086 and 005087 obtain the data for the connection dimension from the following properties:

- **Connection dimension (all)** (ID 20375):
  
  This new property is available to you at "normal" *functions*. The property contains all the connection dimensions of a function, with the connection dimensions of the individual connection points being separated by paragraph marks ("¶").

- **Connection dimension source** (ID 32096) / **Connection dimension target** (ID 32097):
  
  These existing properties are available to you at *connection definition points*. The properties are relevant for fluid power connections such as hoses in the pneumatics.
Connection dimension source (ID 20378) / Connection dimension target (ID 20379):
These new properties are now available to you at conduits / lines. The properties are relevant, for example, for hose lines in the hydraulics.

If you have stored data on the connection dimension at the parts in the parts management, a manual entry of the connection dimension in the properties of a connection / function is not required. At a part or device selection the data for the connection dimension are transferred from the part to the respective function / connection.

Connection dimension in the parts management
The connection dimension is entered in the function templates at parts for functions (for filters, valves, cylinders, etc.). To this purpose the new column Connection dimension has been added in the Function templates tab at those function templates that already have a connection point designation. At a part or device selection these values are transferred to the "Connection dimension (all)" property of the respective function.

Since connections and hose lines do not dispose of connection points, the connection dimension is not entered in the function templates at the associated parts but rather specified as follows:

Fluid power connections: At the parts of the "Fluid power" generic product group from the "Connections" product (for example hoses in the pneumatics that are planned for push-in fittings) the connection dimension is entered in the External diameter field of the Connection data tab. At a part or device selection the external diameter of the first part is transferred to the Connection dimension source and Connection dimension target properties of the respective connection definition point.
- **Hose lines**: At the parts of the "Lines / conduits" product group (for example hose lines in the hydraulics) the connection dimension is entered in the two new fields **Connection dimension source** and **Connection dimension target** of the **Lines / conduits** tab. During a device or part selection the values from the two fields are transferred to the properties of the same name of the respective conduit / line in the schematic.

**Connection dimension and hose line configurator**

Hydraulic hose lines can also be defined by using the hose line configurator (EPLAN Fluid Hose Configurator). In the process four parts are generated at the conduit / line. These are assigned to the fitting left, the fitting right, the hydraulic hose and the complete hose line. To allow the connection dimension to be checked at these hose lines the data for the connection dimension have to be stored in the parts management at the two fittings in the "Accessories" product group.

To this purpose select the new function definition "Fitting / screw connection, 2 connection points" for the respective fittings in the **Function templates** tab respectively and enter the value for the connection dimension in the **Connection dimension** tab. When defining the hose line configurator transfers the respective connection dimensions to the **Connection dimension source** and **Connection dimension target** properties of the hose line in the schematic.

**Specification of the connection dimension**

The two check runs for the connection dimension check that the entered values are the same. This means that the upper case / lower-case usage must be the same when the connection dimensions are entered. Blanks are ignored during checking. An exception is formed by blanks between the digits of mixed fractions. These are combined internally into one blank for the check.
Having the connection dimension in the schematic displayed

The new indexed property **Connection dimension [1-n]** (ID 20374) is available in the property selection of the property arrangement for the connection points so that the connection dimension can be displayed at a function in the schematic. Through the index the respective connection dimension that was specified for the **Connection dimension (all)** property can be displayed per connection point.

In the course of this new feature the following two indexed properties for connection points have been renamed:

<table>
<thead>
<tr>
<th>Old designation</th>
<th>New designation</th>
<th>ID</th>
</tr>
</thead>
<tbody>
<tr>
<td>Symbol: Connection point designation [1-100]</td>
<td>Connection point designation [1-100]</td>
<td>20028</td>
</tr>
<tr>
<td>Symbol: Connection point description [1-100]</td>
<td>Connection point description [1-100]</td>
<td>20029</td>
</tr>
</tbody>
</table>

For further information on this topic, please refer to the help system in the section "Fluid Power-specific Check Runs".
New Features in the "EPLAN API Extension" Extension Module

**Notes:**

- The "EPLAN API Extension" extension module is available as an option as part of our EPLAN Application Developer Network (EADN) as a developer's package for the following program variants: EPLAN Electric P8 Select, EPLAN Electric P8 Professional, EPLAN Electric P8 Professional+, EPLAN Electric P8 Ultimate, EPLAN Fluid, EPLAN Fluid Professional, EPLAN Preplanning P&ID, EPLAN Preplanning Professional, EPLAN Pro Panel Professional, EPLAN Pro Panel Professional+.

- The extension module "EPLAN API Extension" can furthermore be purchased for "normal" licenses (with the exception of EPLAN Electric P8 Compact, EPLAN Fluid Compact).

A unified, and especially high-performance, programming interface (API, Application Programming Interface) is available for EPLAN platform products. This extension module – the EPLAN API – allows you to develop your own customized solutions in collaboration with EPLAN or other partners. For more information about EPLAN API and EADN, visit the EPLAN web pages under the heading "Solutions > Integration > EPLAN Application Developer Network".

The following section provides information on the various new features of EPLAN API. You require the Microsoft .NET Framework 4.5.2 to use the new EPLAN API version to develop your own applications.
Translating individual strings by using the dictionary

Through the new method `TranslateText` from the class `Translate` you can now also translate individual strings by using the dictionary and EPLAN API.

Reloading settings nodes from the settings database

The values of the settings nodes from the settings database are saved temporarily in the RAM while the program is running. Under certain conditions it may be necessary to reload the current value from the database. This can for example be the case if the value is modified by a different EPLAN application. To this purpose the `SettingNode` class now provides the new method `ForceReload`.

Assigning pages to a segment

You can assign pages to a segment of the pre-planning by using the new property `PlanningSegment` from the class `Pages`. You can use the new property `Pages` from the class `PlanningSegment` to obtain a list of all the assigned pages at the segment.

Determining structure identifiers

The `Location` class now no longer contains the outdated removed properties `Parent` and `SubLocations`. These have been replaced by the two new properties `ParentNode` and `SubNodes`. Through the `SubNodes` property you determine the sub-identifier, through `ParentNode` the superior identifier of an identifier in the structure identifier management.
Assigning PLC addresses in the pre-planning

The PlanningSegment class now disposess of the two new methods AddPLCAddress and RemovePLCAddress. These methods allow you to assign specific segments from the pre-planning (planning objects, PCT loops and PCT loop functions) to PLC addresses and to remove them again. You can use the new PLCAddresses property from the same class to determine the PLC addresses assigned at the resegment.

Assign main function

Analog to the menu item Assign main function in the user interface you can now change an auxiliary function into a main function by using EPLAN API. The DeviceService class has been extended by the new method AssignMainFunction to this purpose. In the process the original main function is converted into an auxiliary function.

Removal of outdated methods and properties

Due to the ongoing improvements to the EPLAN platform, some methods and properties of EPLAN API are no longer needed. In the new version of EPLAN API numerous methods and properties, which were outdated already in Version 2.0, have been removed.

Assigning a scheme for the free properties

You can assign a selected scheme to the free properties in the Free properties tab of the parts management. Through the new method AssignFreePropertiesScheme from the class MDPart this is now also possible via EPLAN API.
Determining cross-referenced objects of placeholder texts

In the user interface of the EPLAN platform it is now possible to jump from a placeholder text of a report page to the cross-referenced object in the schematic. So that you can use EPLAN API to determine these cross-referenced objects the PlaceHolderText class now contains the new property SourceObject.

Determining shielded connections

The new Shield class from the namespace Eplan.EplApi.Data-Model.EObjects represents shields. It is now also possible to determine shielded connections and their connection definition points by using the ShieldedConnections property from this class.

Optimizing connections in nets automatically

For automatic optimization of nets in the layout space and connections contained in it the ConnectionService3D class now contains the new method OptimizeNetAutomatically. This optimization is carried out for the current project or for selected routing connections. In the user interface of the EPLAN platform this corresponds to the Project data > Connections > Optimize nets automatically menu items.

Exporting macros

The new action GenerateMacros is available for the macro export. The /PROJECTNAME parameter is used to specify the project from which the macros are to be generated. Otherwise the current project is used.

Note:

Only such projects where the Type of project property is set to "Macro project" are taken into consideration.
Switching the project type

If you have exclusive access to a project, you can now use the `SwitchProjectType` action to switch between the settings "Schematic project" and "Macro project" of the **Type of project** project property. To this purpose set the `PROJECTTYPE` parameter to "1" (schematic project) or "2" (macro project). If the parameter is not set, the system switches to the respective other project type.

Finding planning objects via their name

The class `DMObjectsFinder` now includes the new method `GetPlanningSegments` with which you can find planning objects on the basis of their name.

Finding wire harness objects

The new `Harness` class from the namespace `Eplan.EplApi.DataModel.EObjects` represents wire harnesses. This allows the objects belonging to a specific wire harness to be determined. The following three new methods are available in the `DMObjectsFinder` class for the search for such wire harness objects:

- `GetHarnesses`
- `GetHarnessesWithCF`
- `GetHarnessesWithFilterScheme`.

Carrying out actions in a running application

With the `RemoteClient` class now available from the new namespace `Eplan.EplApi.RemoteClient` it is possible to find a running EPLAN application and to carry out actions in this application.
Finding part master data by means of placeholder characters

Placeholder characters such as "*" and "?" can be used to search for part master data with the new version of the GetParts method from the MDPartsDatabase class.

Specifying a different user interface for an API offline program

The EplApplication class now contains the new method InitGuiLanguage with which you can specify an EPLAN user interface language for API offline programs that differs from the preset user interface language. The messages of the offline program are then displayed in the respective language.

Correcting and reorganizing projects

You can correct and reorganize projects in the user interface of the EPLAN platform by using the two menu items Project > Organize > Correct and … > Reorganize. The ProjectManagement class of the EPLAN API now provides the two new methods CorrectProjectItems and Reorganize to this purpose. In addition the TYPE parameter of the projectmanagement action has been extended with the values CORRECTPROJECTITEMS and REORGANIZE.
All the following new features of the EPLAN API are also relevant for the *EPLAN command line parameters* and in part for the *scripts*. A license is not required for the "EPLAN API Extension" extension module in order to execute the command line parameters and / or scripts.

**Exporting and importing of user-defined properties**

Through the new action `XEsUserPropertiesExportAction` you can now export all the user-defined properties of a project via a command line call, via script or via the EPLAN API. You can use the new action `XEsUserPropertiesImportAction` for an analog import. To this purpose you can use the parameter `/Overwrite` to specify that existing properties be overwritten.

**Deleting stored part properties of a project**

As of Version 2.4 all the part properties are always stored in the project. To allow you to delete specific parts data (such as prices) by alternatively using EPLAN API before passing on a project the `PartsService` class now disposes of the new method `DeleteStoredProperties`. So that this can also be carried out using the command line parameters or via script the `TYPE` parameter of the `partslist` action has had the value `DELETESTOREDPROPERTIES` added to it.

**Checking the part master data by means of command line parameters**

In the message management you can use special check runs to check whether the part master data stored in the parts database are correct and complete. So that this can now also be carried out using the command line parameters the `TYPE` parameter of the `check` action has had the value `PARTS` added to it.
Importing PDF comments into a project

In order to import PDF comments from the "Redlining" into the current project by using EPLAN API the Import class now contains the new method PDFComments. In the user interface of the EPLAN platform this corresponds to the Page > Import > PDF comments menu items. So that this can also be carried out using the command line parameters or via script the TYPE parameter of the Import action has had the value PDFCOMMENTS added to it.

Importing and exporting the property arrangements of a project

The ProjectManagement class now contains the two new methods ImportPropertyPlacementsSchemas and ExportPropertyPlacementsSchemas for the project-wide import and export of user-defined property arrangements. This corresponds to the menu items Project > Organize > Import property arrangements and … > Export property arrangements in the user interface of the EPLAN platform. So that this also possible by using the command line parameters or via script the TYPE parameter of the projectmanagement action has had the values IMPORTPROPERTYPLACEMENTSSCHEMAS and EXPORTPROPERTYPLACEMENTSSCHEMAS added to it.
New Features in the Master Data

Master Data: Symbols

Notes:

- The following pages show a number of illustrations of new symbols from different symbol libraries. The illustrations show variant "A" of the respective symbols in multi-line or single-line representation. The name and number of the symbol are shown underneath the symbol.

- Several symbols dispose of the same symbol graphic. These symbols do, however, differ with regard to usage in the trades, the function definitions, the symbol properties and their positions. New symbols that have the same symbol graphic are displayed together.

IEC, GOST, and GB standards

- New symbols have been added to the symbol libraries IEC_symbol, GOST_symbol and GB_symbol. The following new symbols, among others, are available to you here:

<table>
<thead>
<tr>
<th>Symbol 1</th>
<th>Symbol 2</th>
<th>Symbol 3</th>
<th>Symbol 4</th>
</tr>
</thead>
<tbody>
<tr>
<td>FILS_02_01 // 1140</td>
<td>FILS_04_01 // 1141</td>
<td>SSTO // 1264</td>
<td>QLS2_3 // 1337</td>
</tr>
</tbody>
</table>
New symbols have been added to the symbol libraries IEC_single_symbol, GOST_single_symbol and GB_single_symbol. The following new symbols, among others, are available to you here:
### NFPA standard

- New symbols have been added to the symbol library `NFPA_symbol`. The following *new* symbols, among others, are available to you here:

<table>
<thead>
<tr>
<th>Symbol</th>
<th>Number</th>
</tr>
</thead>
<tbody>
<tr>
<td>QLS2_4</td>
<td>1338</td>
</tr>
<tr>
<td>FA2_2</td>
<td>1339</td>
</tr>
<tr>
<td>FAH2_2</td>
<td>1340</td>
</tr>
<tr>
<td>X3_BU1</td>
<td>1366</td>
</tr>
<tr>
<td>X3_BU2</td>
<td>1367</td>
</tr>
<tr>
<td>LSW1B</td>
<td>1457</td>
</tr>
<tr>
<td>LSW2B</td>
<td>1458</td>
</tr>
<tr>
<td>LSW3B</td>
<td>1459</td>
</tr>
<tr>
<td>QL1_5</td>
<td>1533</td>
</tr>
<tr>
<td>QL2_2</td>
<td>1534</td>
</tr>
<tr>
<td>FILS_02_01</td>
<td>1140</td>
</tr>
<tr>
<td>FILS_04_01</td>
<td>1141</td>
</tr>
<tr>
<td>SSTO</td>
<td>1264</td>
</tr>
<tr>
<td>QLS2_3</td>
<td>1337</td>
</tr>
</tbody>
</table>
New symbols have been added to the symbol library **NFPA_single_symbol**. The following *new* symbols, among others, are available to you here:
All standard symbol libraries

- Corrections have been carried out for several symbols in all standard symbol libraries (modifications of transformation points, correction of the contact image position, harmonization and correction of the symbol descriptions). This applies to the symbol libraries: IEC_symbol, GOST_symbol, GB_symbol, NFPA_symbol, IEC_single_symbol, GOST_single_symbol, GB_single_symbol, NFPA_single_symbol.
- In addition some symbols were replaced by new symbols with corrected symbol graphics in all standard symbol libraries. The old symbols have been locked.

<table>
<thead>
<tr>
<th>Replaced symbol</th>
<th>New symbol</th>
</tr>
</thead>
<tbody>
<tr>
<td>TST_1 // 1152</td>
<td>TST_11 // 1347,</td>
</tr>
<tr>
<td>TST_2 // 1153</td>
<td>TST_21 // 1348,</td>
</tr>
<tr>
<td>TST_3 // 1154</td>
<td>TST_31 // 1349,</td>
</tr>
<tr>
<td>TST_4 // 1155</td>
<td>TST_41 // 1350,</td>
</tr>
<tr>
<td>M2GR // 290</td>
<td>M2GR // 1465,</td>
</tr>
<tr>
<td>M6SCHL // 107</td>
<td>M6SCHL // 1466,</td>
</tr>
<tr>
<td>M9SCHL // 112</td>
<td>M9SCHL // 1467,</td>
</tr>
<tr>
<td>EHX2 // 181</td>
<td>EHX2 // 1468,</td>
</tr>
<tr>
<td>KUB1 // 1030</td>
<td>KUB1 // 1469,</td>
</tr>
<tr>
<td>KUN1 // 309</td>
<td>KUN1 // 1470,</td>
</tr>
<tr>
<td>FS3 // 325</td>
<td>FS3 // 1471,</td>
</tr>
<tr>
<td>YXPE // 1045</td>
<td>YXPE // 1472.</td>
</tr>
</tbody>
</table>

- The symbol graphics of the symbols FA2 // 121 and FA4 // 1195 have been corrected (auxiliary lines added). This change only affects the "multi-line" standard symbol libraries (such as IEC_symbol).

- The symbol graphics has also been corrected in the symbol QL4_1ML // 1197 (auxiliary line added). This change only affects the "single-line" standard symbol libraries (such as IEC_single_symbol).
Fluid power

- The following three new symbols have been added to the symbol libraries PNE1ESS, HYD1ESS and HYD2ESS:

<table>
<thead>
<tr>
<th>Symbol</th>
<th>Reference</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="V11.5.4.6_02" alt="Symbol 1" /></td>
<td>757</td>
</tr>
<tr>
<td><img src="V11.5.4.6_03" alt="Symbol 2" /></td>
<td>758</td>
</tr>
<tr>
<td><img src="V11.5.4.13" alt="Symbol 3" /></td>
<td>759</td>
</tr>
</tbody>
</table>

- In addition, the following new symbols have been added to the PNE1ESS symbol library:

<table>
<thead>
<tr>
<th>Symbol</th>
<th>Reference</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="V11.1.2_14" alt="Symbol 1" /></td>
<td>122</td>
</tr>
<tr>
<td><img src="V11.1.2_15" alt="Symbol 2" /></td>
<td>123</td>
</tr>
<tr>
<td><img src="V11.1.2_16" alt="Symbol 3" /></td>
<td>124</td>
</tr>
<tr>
<td><img src="V7.1.5.3_01" alt="Symbol 4" /></td>
<td>698</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Symbol</th>
<th>Reference</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="V_BT_80_X" alt="Symbol 1" /></td>
<td>782</td>
</tr>
<tr>
<td><img src="V_BT_81_X" alt="Symbol 2" /></td>
<td>783</td>
</tr>
<tr>
<td><img src="V_BT_82_X" alt="Symbol 3" /></td>
<td>784</td>
</tr>
<tr>
<td><img src="V_BT_83_X" alt="Symbol 4" /></td>
<td>785</td>
</tr>
<tr>
<td>V_BT_84_X // 786</td>
<td>V11.5.1_32_30 // 980</td>
</tr>
<tr>
<td>------------------</td>
<td>-----------------------</td>
</tr>
<tr>
<td>V11.5.1_32_33 // 983</td>
<td>V11.5.1_33_03 // 984</td>
</tr>
<tr>
<td>V11.5.1_52_16 // 987</td>
<td>V11.5.1_53_29 // 988</td>
</tr>
</tbody>
</table>
The new category **Sensor** is now available at the function definitions under **Fluid power // Sensors**. The function definitions have been adapted correspondingly at some symbols from the fluid power symbol libraries (**PNE1ESS**, **HYD1ESS** and **HYD2ESS**). The following symbols now have a function definition from the **Sensor** category:

- EA9.1.5 // 344,
- EA9.1.4_01 // 363,
- V_S_006_2 // 368,
- EA9.1.4 // 753,
- V_S_014 // 874*,
- EA9.1.4_02 // 1321,
- EA9.1.4_04 // 1323.

*Symbol is only available in the symbol library **PNE1ESS**.

The symbol descriptions of many symbols have been updated and numbers from the ISO 1219-1 standard added in the symbol libraries **PNE1ESS**, **HYD1ESS** und **HYD2ESS**. For example, the new symbol description **Bellows cylinder (X11600)** is now used for the symbol Z14.5.18 // 29.

In these symbol libraries the symbol graphic of the symbol **V11.5_04 // 157** has been corrected.
In addition some symbols were replaced by new symbols with corrected symbol graphic / changed numbering of the connection points in the symbol libraries HYD1ESS and HYD2ESS. The old symbols have been locked.

### Replaced symbol

<table>
<thead>
<tr>
<th>Replaced symbol</th>
<th>New symbol</th>
</tr>
</thead>
<tbody>
<tr>
<td>V11.5.4.6_01 // 664,</td>
<td>V11.5.4.6_02 // 757,</td>
</tr>
<tr>
<td>V11.5.4.6 // 142,</td>
<td>V11.5.4.6_03 // 758,</td>
</tr>
<tr>
<td>V11.5.1_32_01_d // 60**,</td>
<td>V11.5.1_32_01 // 989**,</td>
</tr>
<tr>
<td>V11.5.1_32_22_d // 594,</td>
<td>V11.5.1_32_22 // 990,</td>
</tr>
<tr>
<td>V11.5.1_53_20_d // 950,</td>
<td>V11.5.1_53_20 // 991,</td>
</tr>
<tr>
<td>V11.5.1_53_21_d // 951,</td>
<td>V11.5.1_53_21 // 992,</td>
</tr>
<tr>
<td>V11.5.1_53_22_d // 952,</td>
<td>V11.5.1_53_22 // 993,</td>
</tr>
<tr>
<td>V11.5.1_53_23_d // 953,</td>
<td>V11.5.1_53_23 // 994,</td>
</tr>
<tr>
<td>V11.5.1_53_24_d // 954,</td>
<td>V11.5.1_53_24 // 995.</td>
</tr>
</tbody>
</table>

*Symbol is also available in the symbol library PNE1ESS. In addition the symbol V_S_012 // 872 has been blocked in the symbol library PNE1ESS.

- The symbol graphic has been corrected at the symbols F15.5_28 // 260 and EA_BT_43 // 1314 from the symbol library PNE1ESS. In the process the symbol F15.5_28 // 260 has been adapted to the current standard ISO 1219-1.

### Special symbol library

- Two new symbols without symbol graphic have been added to the SPECIAL symbol library:
  - HDEF // 62 // Wire harness definition point
  - DCP2NG // 511 // Device connection point, two-sided (invisible).

### General

- The GRAPHICS symbol library has the following new symbols:
<table>
<thead>
<tr>
<th>WEH_RD // 100</th>
<th>WEH_BU // 101</th>
<th>WEH_YE // 102</th>
<th>WEH_WEH // 103</th>
</tr>
</thead>
<tbody>
<tr>
<td>WEH_GY // 104</td>
<td>WEH_BK // 105</td>
<td>WEH_BLANK // 106</td>
<td>WES_RD // 110</td>
</tr>
<tr>
<td>WES_BU // 111</td>
<td>WES_YE // 112</td>
<td>WEG_RD // 115</td>
<td>WEG_BU // 116</td>
</tr>
<tr>
<td>WEG_YE // 117</td>
<td>WER_RD // 120</td>
<td>WER_BU // 121</td>
<td>WER_YE // 122</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>----------------</td>
<td>----------------</td>
<td>----------------</td>
<td>----------------</td>
</tr>
<tr>
<td>W_RD // 130</td>
<td>W_BU // 131</td>
<td>W_YE // 132</td>
<td>W_WH // 133</td>
</tr>
<tr>
<td>W_OG // 134</td>
<td>W_GN // 135</td>
<td>W_PK // 136</td>
<td>W_VT // 137</td>
</tr>
<tr>
<td>W_TQ // 138</td>
<td>W_BN // 139</td>
<td>W_SR // 140</td>
<td>W_GY // 141</td>
</tr>
<tr>
<td>W_BK // 142</td>
<td>W_GNYE // 143</td>
<td>W_SH // 144</td>
<td>W_RDBU // 145</td>
</tr>
<tr>
<td>W_WHRD // 146</td>
<td>W_WHBU // 147</td>
<td>W_WHGY // 148</td>
<td>W_WHOG // 149</td>
</tr>
<tr>
<td>-----------------</td>
<td>-----------------</td>
<td>-----------------</td>
<td>-----------------</td>
</tr>
<tr>
<td>W_WHPK // 150</td>
<td>W_WHVT // 151</td>
<td>W_WHBN // 152</td>
<td>W_WHBK // 153</td>
</tr>
<tr>
<td>W_GYPK // 154</td>
<td>KILL // 160</td>
<td>DIP_SW // 161</td>
<td>C_ARROW0_10 // 170</td>
</tr>
<tr>
<td>C_ARROW1_10 // 171</td>
<td>C_ARROW2_10 // 172</td>
<td>C_ARROW3_10 // 173</td>
<td>C_ARROW4_10 // 174</td>
</tr>
</tbody>
</table>
Many symbols had German names in the GRAPHICS symbol library. These symbol names have been replaced by neutral names in this version. For example the new name XTR_1 is now used for the symbol X_Trennklemme // 5.

Master Data: Forms and Plot Frames

The following three new plot frames were created:

- FN1_013.fn1
- FN1_014.fn1
- FN1_077_en_US.fn1.

In addition the following new form has been created:

- F26_004.f26 (file type "Title page / cover sheet")
Mechanics

Three new forms have been created for the new report and the "Cut-out legend" form type:

- F47_001.f47
- F47_002_AB.f47
- F47_002_C.f47 (sub-form for the form F47_002_AB.f47).

Color changes for plot frames and forms

In the past the lines, special texts and placeholder texts in the plot frames and forms supplied by EPLAN were green. In order to optimize the display, the following layers have been set to the background-dependent color "Black" in the plot frames and forms:

- EPLAN200, Graphic.Forms
- EPLAN201, Graphic.Plot frames
- EPLAN450, Special texts.Placeholder texts
- EPLAN451, Special texts.Projects
- EPLAN452, Special texts.Pages
- EPLAN453, Special texts.Columns / Rows.

This results in all the lines and texts in the EPLAN plot frames and forms being displayed in "Black" in the case of "default color settings" - thus offering a better contrast to the background.
Master Data: Function Definition Library

Some new function definitions have been added to the function definition library. For further information on the properties, the basic symbol, etc. of the function definitions listed below in the Function definitions dialog, navigate to the location indicated in the Selection field.

Trade: General

- The following new function definition has been added under General // General special functions // Wire harness // Wire harness:
  - Wire harness definition

Fluid power trade

- The following new function definition has been added under Fluid // Connection splicer / line connector, accessories // Fitting / screw connection // Fitting / screw connection, 2 connection points:
  - Fitting / screw connection, 2 connection points

- Under Fluid power // Sensors // Sensor // Graphic, the following new function definition has been added:
  - Graphic

- Under Fluid power // Sensors // Sensor // Sensor, 1 fluid power connection point, the following new function definitions have been added:
  - Pressure sensor
  - Flow rate sensor
  - Level sensor
  - Sensor, general
  - Temperature sensor
Under Fluid power // Sensors // Sensor // Sensor, 2 fluid power connection points, the following new function definitions have been added:
- Pressure sensor
- Flow rate sensor
- Level sensor
- Sensor, general
- Temperature sensor

Under Fluid power // Sensors // Sensor // Sensor, variable, the following new function definition has been added:
- Sensor, variable

The following new function definition has been added under Fluid // Valve, distributor, and logic item // Valve // Valve, 2 connection points:
- Quick exhaust valve, 2 connection points

The following new function definition has been added under Fluid // Valve, distributor, and logic item // Valve // Valve, variable:
- Quick exhaust valve, variable

The following new function definition has been added under Fluid // Valve, distributor, and logic item // Directional control valve // 5/3 directional control valve:
- 5/3 directional control valve, 1>4,2>3,5
Master Data: Identifiers

- The identifiers in the columns IEC, IEC 61346, IEC 81346, NFPA and GB/T 5094 have been extended and corrected in the dialog Suggested identifiers. (The menu path for this dialog is: Utilities > Master data > Identifier.)

Master Data: Projects and Templates

- Pre-defined structure identifiers for the document type have added to the following project templates / basic projects in accordance with the IEC 61355 standard:
  - IEC_tpl002.ept
  - IEC_bas002.zw9
  - FL_1219-2_tpl001.ept
  - FL_1219-2_bas001.zw9

- In the project settings for distributed terminals the check box Connect associated distributed terminals automatically is now activated by default and the check box Jumper optimization is deactivated by default. The project templates / basic projects have been adapted correspondingly.
Other New Features and Information

EPLAN Solution Center – the Support System

Since the start of 2013, you have been able to access our support system online – the EPLAN Solution Center.

**Benefit:**

*The EPLAN Solution Center is an optimized support system with improved service. As a result, we can now process your individual support requests even more efficiently.*

Your inquiries are created and managed in the EPLAN Solution Center on the basis of simple, ergonomic dialogs. Settings once configured are stored automatically for future inquiries. You can view the processing status of your inquiry at any time.

A knowledge database has been integrated into this support system, which already contains a large number of answers to frequently asked questions. As soon as your inquiry is received, the knowledge database – the EPLAN Knowledge Center – automatically suggests initial solutions, provided the topic has already been dealt with before. The knowledge database is expanded continuously.

A link to the EPLAN form is also integrated into the EPLAN Solution Center. This allows you to use the discussion platform directly.

Logging Into the EPLAN Solution Center

Only software service customers can log into this support system. To access it, please register online with EPLAN Support. You can reach the registration
page, for example, by clicking the "EPLAN Solution Center" hyperlink from within our support section.

From within the EPLAN platform it is also possible to directly jump to the login page. For this select the **Create EPLAN support request** menu item from the **Help** menu. Your Internet browser will then open on the page for logging into the EPLAN Solution Center.
Notes:

- You must have entered values in the dialog **Settings: User code / address** for the fields **E-mail** and **Customer number** so that you can place a support request directly from the EPLAN platform. If this is not the case, a prompt is opened after you have selected the menu item **Create EPLAN support request** and you can add these settings in a subsequent dialog.

- Please note that you cannot use your login information that you use for logging into EPLAN Support on the Internet page with the login. You must register once before being able to use the EPLAN Solution Center. Enter the e-mail address that you have used so far also for communicating with EPLAN Support in the **E-mail address** field, and then click **[Register]**.

To log into the EPLAN Solution Center, enter in the fields **User name** and **Password** the data that you received in a reply e-mail from EPLAN.

Confirm your specifications by clicking **[Register]**. The first time you log in, you will be prompted to change the password that was assigned to you. Then, the start page of the EPLAN Solution Center opens.
Validation Code

To use this new version of EPLAN, you need a new validation code. This is provided on the delivery note sent with your storage medium. In addition, you have the option of retrieving the validation code via the internet (see the following section).

Retrieving the Validation Code Online

EPLAN enables you to carry out the final installation step quickly and easily by allowing you to retrieve the validation code required for licensing via the internet. After the required data have been transmitted, the validation code is automatically copied into the license dialog.

Note:

Please note that you must be connected to the internet to download the validation code. You cannot retrieve a validation code for network licenses or licenses without a dongle.

The Enter validation code dialog has been enhanced to allow you the option of retrieving the validation code online.
This dialog, for example, opens when you start the application for the first time after an installation. Click the new [Retrieve online] button.

The **Company name** and **Serial number** are automatically entered into the open **Set validation code online** dialog. This data is needed to retrieve the validation code successfully.

**Up-to-date information**

If you would like to receive information in the future (such as our eNewsletter), please activate the **I would like to receive further information** check box. EPLAN will then save your personal details (**Name**, **Phone**, **E-mail address**, etc.).

**Internet settings**

The settings for the existing internet connection are adopted by default. You can also use a proxy server as a network component via the [Settings] button and the dialog that then opens. If this is the case, you must enter the corresponding information on **Address**, **Port**, etc. Please consult with your administrator about the settings in this area.

**Returning the validation code**

Click [Send] to send the encoded data to EPLAN. If your details are already held by EPLAN and are valid, a validation code is created and sent to the license dialog. Then start the application by clicking [OK].
Software Requirements and Approvals

Note:
The programs of the EPLAN platform are only available as a 64-bit version in the current Version 2.6.

General requirements

The Microsoft .NET framework 4.5.2 is required to operate the EPLAN platform. Further information and the current version of this Microsoft component are available for download from the Microsoft website.

You will find .NET Framework 4.5.2 on your EPLAN storage medium. Switch to the following directory:

```
cd-rom\Services\Net Framework 4.5.2
```

To install .NET Framework, double-click the file `NDP452-KB2901907-x86-x64-AllOS-ENU.exe`.

Operating systems

The EPLAN platform supports the 64-bit variants of the Microsoft operating systems Windows 7, Windows 8 / 8.1 and Windows 10. The EPLAN language installed must be supported by the operating system.

The EPLAN platform has been cleared for the following operating systems:

Workstation

- Microsoft Windows 7 SP1 (64-bit) Professional, Enterprise, Ultimate
- Microsoft Windows 8 (64-bit) Pro, Enterprise
- Microsoft Windows 8.1 (64-bit) Pro, Enterprise
- Microsoft Windows 10 (64-bit) Pro, Enterprise

**Server**
- Microsoft Windows Server 2008 R2 (64-bit)
- Microsoft Windows Server 2012 (64-bit)
- Microsoft Windows Server 2012 R2 (64-bit)
- Terminal Server with Citrix XenApp 7.6 and Citrix Desktop 7.6

**Microsoft products**
Prerequisite for the creation of Microsoft Office file formats from EPLAN is a functioning installation of an Office version as approved by EPLAN on the PC.

- Microsoft Office 2010 (32-bit and 64-bit)*
- Microsoft Office 2013 (32-bit and 64-bit)*
- Microsoft Office 2016 (32-bit and 64-bit)*
- Microsoft Internet Explorer 10
- Microsoft Internet Explorer 11
- Microsoft Edge

*Depending of the selection of the databases for the parts management, the project management and the dictionary, the use of a 64-bit Office version is compulsory.

**SQL Server (64-bit)**
- Microsoft SQL Server 2012
- Microsoft SQL Server 2014
Autodesk Server (64-bit)

- AutoCAD 2015
- AutoCAD 2016
- Autodesk Vault**

**The approvals are specified in the software prerequisites of the current performance description of the Vault Connector.

PDF redlining

- Adobe Reader Version XI
- Adobe Acrobat Version XI Standard / Pro
- Adobe Reader Version DC
- Adobe AcrobatVersion DC Standard / Pro

PLC systems (PLC & bus extension)

- ABB Automation Builder 1.1
- Beckhoff TwinCAT 2.10
- Beckhoff TwinCAT 2.11
- 3S Codesys
- Mitsubishi GX Works2
- Rockwell RSLogix professional 20
- Rockwell RSLogix professional 21
- Schneider Unity Pro 8.1
- Schneider Unity Pro 10.0
- Siemens SIMATIC STEP 7 version 5.4 SP4
- Siemens SIMATIC STEP 7 version 5.5
64-bit version of the EPLAN platform

Since the EPLAN platform is available as a 64-bit version, please observe the following points:

If you want to use Access databases for the parts management, the project management and the dictionary, both the Microsoft operating system and the Microsoft Office applications (inter alia Microsoft Access) have to be installed completely in the 64-bit version.

If you have installed the Microsoft Office applications in the 32-bit version, you have to use SQL Server databases for the parts management, the project management and the dictionary.

A changeover to SQL Server databases is not possible for EPLAN PPE. In order to use EPLAN PPE in the 64-bit version, both the Microsoft operating system and the Microsoft Office applications (inter alia Microsoft Access) therefore have to be installed completely in the 64-bit version.

Note:

The Microsoft Access Runtime component is furthermore required in order to use Access databases in EPLAN. This component is installed as well when Microsoft Access is installed at Microsoft Office installations up to and including Microsoft Office 2013. The component is not included in an installation of Microsoft Office 2016.

In this case or if you use Microsoft Office without Microsoft Access, you can download the Microsoft Access Runtime component as a separate download from the Microsoft Internet site.
Further information (for example about the installation of the 64-bit version, the automatic update of projects, etc.) is available under:
http://www.eplan.info/quickstart

Modified Hardware Prerequisites

As of Version 2.6 the EPLAN Platform can only be run on computers with multi-core processors.